xas Department of Agriculture
iti ivision

DIRECT
CERTIFICATION
AND DIRECT
VERIFICATION
SYSTEM USER
MANUAL

SY 2017



1. INTRODUCTION
1.1 Welcome

1.2 Direct Certification and Verification User Manual

2. QUICK OVERVIEW

3. DIRECT CERTIFICATION REGULATION, PROCESS, AND POLICY

3.1 Regulations
3.1.1 Direct Certification Regulation
3.1.2 Personal Identifiable Information:
3.1.3 Records Retention:

3.2 Policy
3.2.1 USDA Direct Certification Policy
3.2.2 Texas Direct Certification Policy

3.3 Direct Certification Process
3.3.1 Data Process
3.3.2 How a match is made
3.3.3 LEA Direct Certification Process

4. LOGGING-ON TO THE DCDV MODULE

4.1 Getting Started with the DCDV Module
4.1.1 Equipment
4.1.2 Minimum Browser Requirements
4.1.3 Preferred Screen Resolution
4.1.4 TX-UNPS User ID
4.1.5 Accessing the TX-UNPS Web Site

4.2 Logging On to TX-UNPS
4.2.1 Log on:
4.2.2 TX-UNPS Programs Page:
4.2.3 School Nutrition Programs Home Page:
4.2.4 Access the School Nutrition Programs Home Page:
4.2.5 Access the Direct Certification Module
4.2.6 Logging Out
4.2.7 Protect Your Identify

O© O ©

10

10
10
10

11
11
12
12

13

13
13
13
14
14
14

15
15
15
16
16
17
18
18

Texas Department of Agriculture DCDV System User Manual

Introduction
Page 2



5. DIRECT CERTIFICATION MATCHING
5.1 Access a State Match List for Direct Certification
5.2 Print/Download Direct Certification Matches
5.2.1 Report Type and Parameters
5.2.2 View or Print a Direct Certification List

5.3 Export List

5.4 Download a Direct Certification List
5.4.1 Save Messages in Different Browsers
5.4.2 Save Downloaded File

5.5 Match List Contents

5.6 CE Import for CE Level Matches
5.6.1 CE Import Process
5.6.2 CE Match File

5.7 CE Search for Individual Matches

5.8 Direct Certification Reporting

6. QUICK OVERVIEW — DIRECT VERIFICATION

DIRECT VERIFICATION PROCESS AND POLICY VERIFICATION

6.1 Direct Verification
6.2 Verification Time Period

6.3 Direct Verification Policy

7. DIRECT VERIFICATION

7.1 Log-on to DV Module

7.2 Manual Search Case/Eligibility Determination Group (EDG) Number

7.3 Manual Search without Case/EDG Number
7.3.1 Search Parameters
7.3.2 Print an Individual Direct Verification Record

19

19

20
20
21

23

25
25
27

27
28
28
29
31

33

35

36

36

37

37

39
39
39
42

43
43

Texas Department of Agriculture DCDV System User Manual

Introduction
Page 3



7.4 Batch Upload Search of Direct Verification Records
7.5 Saving the File
7.6 To View or Print a Listing of All Direct Verification Matches

7.7 To Download a Listing of All Direct Verification Matches

8. ACRONYMS

9. WHAT IS THE DIFFERENCE BETWEEN DC AND DV?

10. FOLDER STRUCTURE

11. HOW TO SAVE A FILE AS A CSV FILE
11.1 How to Save a File in Excel in 97-2003:

11.2 How to Save a File in Excel 2007 or Later

12. FORMATTING EXCEL FILE FOR CE IMPORT PROCESS
12.1 Save Copy of File
12.2 Right Columns/Right Order

12.3 Format Social Security Number
12.3.1 Find and Replace

12.4 Format Date of Birth

12.5 Format CE ID

13. IMPORT TEXT FILE TO EXCEL

14. MAKING THE DOWNLOAD FILE USER FRIENDLY

14.1 Formatting an Excel Spreadsheet
14.1.1 Resize Columns
14.1.2 Page Set-up

45

49

49

50

52

53

54

56

56

56

58

58

58

59
60

61

62

63

66

66
66
67

Texas Department of Agriculture DCDV System User Manual

Introduction
Page 4



15. CORRECTING INVALID DATA 74

15.1 How to Filter 75
16. LIST DOESN’T LOOK RIGHT; CAN'T PRINT ALL THE PAGES 78
17. REDACTING SSN 81
18. PASSWORD PROTECTING FILES 85
18.1 Identify Excel Version 85
18.2 Excel 2003 86
18.2.1 Identify Excel 2003 86
18.2.2 Password Protect in Excel in 2003 87
18.3 Excel 2007 89
18.3.1 Identify Office 2007 89
18.3.2 Password Protect in Excel 2007 90
18.4 Excel 2010 92
18.4.1 Identify Office 2010 92
18.4.2 Password Protect Excel 2010 92
18.5 Excel 2013 and Office 365 92
18.5.1 Identify Office 2013 and Office 365 92
18.5.2 Password Protect in Excel 2010, 2013 and Office 365 93
19. ADOBE ACROBAT READER 95
19.1 Download the Adobe Acrobat Reader 95
19.2 Check for Updates 96
19.3 Enable Automatic Updates 96
20. EXCEL VIEWER 97
21. ENABLE POP-UPS 98
21.1 Enable Pop-Ups in Chrome 98

Texas Department of Agriculture DCDV System User Manual
Introduction
Page 5



INTRODUCTION

21.2 Enable Pop-Ups in Firefox 98
21.3 Enable Pop-ups in Internet Explorer 99
21.4 Select Save Changes. Enable Pop-Ups in Microsoft Edge 99
22. TIPS FOR COMPLETING THE VERIFICATION REPORT 100
23. DECISION PATHS 105
23.1 SNAP is Always #1 105
23.2 The Address is What Matters 105
24. INDEX 109

Version 1.1 Updated 6/23/2017 by Lee Ann Dumas

Texas Department of Agriculture DCDV System User Manual
Introduction
Page 6



1. Introduction

1.1 Welcome

Welcome to the Texas Department of Agriculture Food
and Nutrition Division Direct Certification and
Verification (DCDV) user manual.

1.2 Direct Certification and Verification User Manual

This user manual is intended for use by authorized CE
that operates the School Nutrition Program (SNP). It is
designed to provide clear and complete instructions for
conducting the Direct Certification and the Direct
Verification processes.

The user manual is set up with wide left margins to
allow space for writing notes. If you find errors, or have
a tip that makes the process easier, please send the
information in an email to
DirectCertification@TexasAgriculture.Gov
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2. QUICK OVERVIEW

What is Direct
Certification?

Process that provides certification for free meal
benefits for eligible children without an application.

Who is eligible?

Children who reside in a household receiving
Supplemental Nutritional Assistance Program (SNAP)
and/or Temporary Assistance for Needy Families
(TANF) benefits.

Who has to do Direct
Certification?

Any local education agency (LEA) - public, private or
charter — that participates in the National School
Lunch Program (NSLP) and/or the School Breakfast
Program (SBP).

An RCCI that has day students who submit meal
applications is also required to do Direct Certification.

How often must an LEA
directly certify matches?

LEAs participating in NSLP/SBP in Texas must
complete the Direct Certification process monthly.
This includes any LEA participating in special provision
programs such as Provision 2 and Community
Eligibility Provision (CEP).

How do you do Direct
Certification?

The Direct Certification process has several steps —
confirming the current enroliment of students on the
State Match list and searching for more eligible
students through the CE Upload process or CE Search
process. Then the CE must enter the information into
the point-of-sale (POS) system.

The state only matches students. It is the CE that
certifies them.

Why is there so much
focus on Direct
Certification?

It’s required by law.

The state must meet a benchmark that 95% of
eligible student are certified by LEAs participating in
NSLP/SBP.

All LEAs must report the number of students enrolled
on the last day of October that have been directly
certified. This is reported on The Verification located
in TX-UNPS.
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3. Direct Certification Regulation, Process, and

Policy

3.1 Regulations

While you are required to
keep the DC
documentation, you are
not required to keep the
PIl. The SSN can be
deleted from lists before
printing or saving
electronic files.

Confirm with the support
for the POS system if SSN
is required for loading
student eligibility data.

3.1.1 Direct Certification Regulation

Direct Certification is the process that allows school-age
children residing in households that receive
Supplemental Nutrition Assistance Program (SNAP) or
Temporary Assistance to Needy Families (TANF)
benefits to participate in the National School Lunch
Program (NSLP) and the School Breakfast Program
(SBP) without submitting an application and at no
charge. The Child Nutrition and WIC Reauthorization
Act of 2004 mandated that all Local Education Agencies
(LEA), including private schools, would have direct
certification systems in place by School Year 2008.

3.1.2 Personal ldentifiable Information:

The matching process for Direct Certification uses the
child’s Social Security Number (SSN) as the primary
matching field. The SSN is Personal Identifiable
Information (PIl). The Family Educational Rights and
Privacy Act (FERPA) allows the use of PII for purposes
such as Direct Certification.

Prior to beginning the process, discuss with the district
or school’s technology staff and administration what the
policies and procedures will be for handling
documentation results. Printed copies must be stored in
locked cabinets or drawers. Electronic files must be
stored on secured drives.
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3.2 Policy

3.1.3 Records Retention:

Record retention guidelines requires that public and
charter schools maintain direct certification and
verification documentation for five (5) years after the
last claim is filed for the pertaining fiscal year. Private
schools and RCCls are required to retain documentation
for three (3) years.

As part of the security and records retention plan,
designate in advance what electronic files will be named
and where they will be stored. TDA recommends that
files be stored in folders labeled with the school year.
Individual files should contain the report date in the file
name. See suggesting folder structure and file naming
in the Appendix. (Page 53)

3.2.1 USDA Direct Certification Policy

The Administrator’s Reference Manual, Section 4:
Determining Eligibility contains policy information
regarding direct certification.

3.2.2 Texas Direct Certification Policy

The Texas Department of Agriculture requires that all
LEAs, public, private, and charter, that participate in
NSLP/SBP conduct the direct certification process
monthly. Residential Child Care Institutions (RCCI) that
have day students and accept meal applications from
the day students are also required to conduct direct
certification process monthly. Any LEA participating in
special provision programs such as Provision 2 and the
Community Eligibility Provision (CEP) is also required to
conduct the direct certification process monthly.
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3.3 Direct Certification Process
3.3.1 Data Process

Each month, the Health and Human Service
Commission (HHSC) sends to the Texas Education
Agency (TEA information on all persons under the age
of 22 living in a household receiving SNAP or TANF
benefits. All children between the ages of 5 and 18 that
receive SNAP benefits are flagged. TEA then matches
the information to school enrollment data. TEA then
sends the matched and unmatched data to the Texas
Department of Agriculture (TDA). TDA loads the
matched and unmatched data into a secure database.

Local Education Agencies (LEA) contracted with TDA for

HHSC *SNAP/TANF

recipients
eMatch
TEA recipients
to LEA

TDA eProvide access

to matches

eDirectly certify
LEA matches

the NSLP/SBP can access the data to find eligible
children for certification. The data matched to an LEA’s
enrollment information is provided as a State Matched
List. The LEA downloads the State Match Lists and
certifies currently enrolled students in the Point-of-Sale
(POS) system. The LEA must then upload current
enrollment data to find matches in the unmatched data
pool, or search by individual student. All matches made
must be identified as directly certified in the POS

Texas Department of Agriculture DCDV System User Manual
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system. The LEA must report annually the number of
children directly certified that were enrolled the last
operating day of October.

3.3.2 How a match is made

There are five fields used in the matching algorithm.
TEA uses a matching process that requires exact match
on four fields. The fields are

e Social Security Number (SSN)
e Last Name

e First Name

e Date of Birth (DOB)

e Gender

The primary match is made using the SSN and any
three exact matches of the other four fields.

If the SSN does not match, then all of the other four
fields must be exact matches.

The CE Import process, also known as the CE Upload
process, must have exact matches on all five fields.

3.3.3 LEA Direct Certification Process

The Direct Certification process requires two-steps:

o Download the state list of matches and certify the
students currently enrolled. Identify and tag the
students as SNAP or TANF in point-of-sale (POS)
system.

e Upload student enrollment data to search for
possible matches. Identify and tagged matched
eligible students in POS system.

Texas Department of Agriculture DCDV System User Manual
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4. Logging-On to the DCDV Module
4.1 Getting Started with the DCDV Module
4.1.1 Equipment

In order to fully utilize the DCDV module, you will need
the following:

e A computer with internet access
e Adobe PDF Reader
e Excel Viewer if you do not have MS Office

¢ TXUNPS User ID and Password

4.1.2 Minimum Browser Requirements

There are problems TDA supports only modern browsers which also provide

with the improved security and performance.
Print/Download screen

in Firefox. We
recommend that you
use Internet Explorer
or Chrome.

TDA does support the latest version of Google Chrome
(which automatically updates whenever it detects that a
new version of the browser is available). TDA supports
the current and previous major releases of Firefox,
Internet Explorer, and Safari on a rolling basis. Each
time a new version is released, TDA begins supporting
that version and stops supporting the third most recent
version.

Texas Department of Agriculture DCDV System User Manual
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You will receive an
“unauthorized user”
message if you have
just changed your
password.

4.1.3 Preferred Screen Resolution

The minimum screen resolution for desktop is 1024 x
768 pxX.

4.1.4 TX-UNPS User ID

TX-UNPS serves as the security gateway for DCDV.
Before you can begin using TX-UNPS and the DCDV
module, you must be assigned a user ID and password
by the TX-UNPS Help Desk. To access and use the
DCDV module, you must have the SNP CE Admin
security group. Once this setup is complete, you may
use the Internet and your assigned user ID and
password to access and log onto the TX-UNPS web site.

Your password for TX-UNPS must be updated every 90
days. When a TX-UNPS password is changed, it must be
updated in the TDA database before you can access the
DCDV module. The database is refreshed about 6 PM
every evening. Normally you can access the DCDV
module the next day after changing your password. If
you change your password late in the evening, you may
have to wait two days before accessing the DCDV
module.

The TDA Helpdesk can assist you with your TX-UNPS
log-on. Call -1-877-TEX-MEAL (877-839-6325).

4.1.5 Accessing the TX-UNPS Web Site

You can log-on to TX-UNPS from any computer
connected to the Internet by opening your Internet
browser and entering the following URL in the browser’s
address line:

https:/itxunpsl.texasagriculture.gov

The TX-UNPS log-on page will open (Figure 1).
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Figure 1 TX-UNPS Log-on

4.2 Logging On to TX-UNPS

4.2.1 Log on:

e Enter your TX-UNPS User
If a user only has

access to the School e Enter your password.
Nutrition Programs
module, the Programs

screen is not be 4.2.2 TX-UNPS Programs Page:
displayed.

e Select Log On.

Once you successfully log on, the TX-UNPS Programs
page is displayed (Figure 2).
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DIRECT CERTIFICATION

Programs

——
Srere

FIGURE 2 TX-UNPS PROGRAM PAGE

4.2.3 School Nutrition Programs Home Page:

The School Nutrition Programs home page contains the
message board used by state administrators to post
and maintain School Nutrition Programs-related
messages. Messages contain important news regarding
the submission due dates, upcoming training, legislative
changes, or any other SNP-specific information.
Announcements regarding Direct Certification and
Verification will be posted here as well.

4.2.4 Access the School Nutrition Programs Home
Page:

¢ On the Programs screen, select School Nutrition
Programs, the blue tile on the top-row, left-side.

Texas Department of Agriculture DCDV System User Manual
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DIRECT CERTIFICATION

¢ The School Nutrition Programs home page displays
(Figure 3).

School Nutrition Programs TX-UNPS Q.’._

Welcome to the Texas Unified Nutrition Programs System

Ficure 3 SNP HoME PAGE

4.2 .5 Access the Direct Certification Module

o Select Applications from the blue menu bar at the
top (Figure 4).

School Nutrition Program

Applications | Claims | Compliance | Reports | Security | Search

FIGURE 4 BLUE MENU BAR

. From the Applications list, select Direct
Certification/Direct Verification (near bottom of list)

(Figure 5)

Item
Contracting Entity Manager

Application Packet

Meal Pattern Compliance Summary
Verification Report

Verification Summary

Food Safety Inspections

Food Safety Inspections Summary

Summer Nutrition Program Costs
Capital Expend; equest |
Site Enrollment

Community Eligibility Provision

Texas Summer Mandate

Direct Certification / Direct Verification

FIGURE 5 APPLICATIONS MENU
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The screen will not
open if you have a
pop-up blocker
running on your
system. If this
occurs, hold down
the CTRL key and
select Direct
Certification / Direct
Verification again.

e From the DCDV program page, select the Direct
Certification/Direct Verification link at bottom of
page (Figure 8)

.Fppicdiu1§|dﬂ"ns|ﬂwnpii1c¢|ﬂq:uts|5m1'

Applications > Direct Certification / Direct Verification >

Direct Certificati

Direct certification (DC) is a method of directly ¢
due to the household receiving SHNAP (Supplement
Assistance for Needy Families) benefits. TDA prov
required DC regulation.

Direct verification is @ method of verifying proar
reduced-price meals using state SNAP, TANF, CHII
TDA provides direct verification information begine
verification regulation.

Click on the link below to go to the Direct Certifica
e s et to all

Direct Certification / Direct Verification

Figure 6 DCDV Link Page in TX-UNPS

By selecting the Direct Certification / Direct Verification
link on this screen, a new browser window will open
providing access to the Direct Certification/Direct
Verification module.

4.2.6 Logging Out

When you complete a DCDV Module session, please
logout. Your TX-UNPS browser session will remain
active until the system times out (i.e., 20 minutes). If
using the Direct Certification-Direct Verification module
takes longer than 20 minutes, you will need to re-login
to TX-UNPS. If you must leave the computer, please
logout so that another person who might use your
computer cannot have access to information within
DCDV.

4.2.7 Protect Your ldentify

You should keep your User ID and password in a secure
location and you should not share it with anyone.

Texas Department of Agriculture DCDV System User Manual
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5. Direct Certification Matching
5.1 Access a State Match List for Direct Certification

After selecting the Direct Certification/Direct Verification
link in TX-UNPS, a new browser window will open
displaying the Direct Certification-Direct Verification
Home Page.

Click the Direct Certification link in the upper left corner
to go to the Direct Certification screens (Figure 7).

Direct Certifica

Direct Certification Direct Yerification

FicurRe 7 DCDV OPEN SCREEN

If you are a CE user only associated with one
Contracting Entity, the Contracting Entity ID,
Contracting Entity Name and CD Code fields will be pre-
populated.

If you are a CE user with access to multiple Contracting
Entities, the Contracting Entity ID field will be blank.

Contracting Entity ID:

Enter the 5-digit CE ID you
wish to access and click the Tab key. The Contracting
Entity Name and CD Code will populate based on the
entered CE ID.

If you enter a CE ID that is not associated with your
user account, you will receive an error message.

Texas Department of Agriculture DCDV System User Manual
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DIRECT CERTIFICATION

The Direct Certification Home Page will open (Figure 8)

Direct Certification Home Page

Print/Download Direct Certification Matches

CE Import for CE Level Matches

Search Page for CE Level Matches

Ficure 8 DC HoME PAGE MENU

5.2 Print/Download Direct Certification Matches
5.2.1 Report Type and Parameters

Select the Match List you want to access.

Report Type

® State Level Matches ) CE Level Matches
Report Parameters

[ vear to Date List

Update Period Select Month ¥

| View/Print | | Download |

Figure 9 Report Type and Parameters

e Report Type

o0 State Level Matches — Matches made with
SNAP/TANF data and TEA October
Snapshot. New list is available each
month.

o0 CE Level Matches — Matches made with
SNAP/TANF data and CE enrollment data
through CE Upload process. List available
for each month that CE has matches.

Texas Department of Agriculture DCDV System User Manual
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e Report Parameter

0 Year to Date List— Comprehensive list
which includes all records matched during
the current school year beginning in July
to current month If the CE did not have
any CE Level Matches in a particular
month, that month will not be on the
report.

o0 Select month — Select a month from the
“Updated Period” drop-down list to view
only records matched during a specific
month. If the CE did not have any CE Level
Matches in a particular month, that month
will not be listed.

5.2.2 View or Print a Direct Certification List

After selecting a Report Parameter, click the View/Print
button. The requested Direct Certification list will

display on the screen (Figure 10).

5 o

DirectCartification rpt

NEW BOSTON ISD-019905
" 001 - NEW BOSTON H §*

LAST NAME EIEST MAME Bl

b M 1/32

=] #

TEXAS DEPARTMENT OF AGRICULTURE Page 10f 32
PEIMS - STATE LEVEL MATCHES
DIRECT CERTIFICATION FOR NATIONAL SCHOOL LUNCH

2015-2016

Year to Date

ssN BIRTHDATE sy GRADE  ADDRESS CITY STATE 2P MATCHDT EFEDT  EUG

FIGURE 10 VIEW/PRINT LIST

Click the printer icon (under the Direct Certification
link) to print the list of students (Figure 11).

P [

Figure 11 Print DC Lists
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Are the columns
spread very far apart?

Do the rows go up
and down?

Will it print only a few
pages?

See page 63 in the
Appendix for solution

DIRECT CERTIFICATION

A pop-up box appears asking for the page range.
Select “All” and click “OK” (Figure 12.

Print Options

Enter the page range that you want to Print.
o All

® Pages

From: 1 |To: 1 |

To Print:

1. In the next dialog that appears, select the "Open this file"
option and click the OK button.

2. Click the printer icon on the Acrobat Reader Menu rather
than the print button on your internet browser.

FIGURE 12 PRINT OPTIONS

The list will display in PDF format. Click the printer icon
on the page (Figure 13). You can see it when you move
the mouse cursor near the bottom of the page.

mQ@sB

FIGURE 13 PRINTER ICON FOR PDF IN CHROME

EE)

FIGURE 14 PRINTER ICON FOR PDF IN INTERNET EXPLORER

Close the PDF window.

Texas Department of Agriculture DCDV System User Manual
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5.3 Export List

The Print screen also gives the option to export the file
to other formats. Select the Export Icon on the left to
see the options. (Figure 15)

B

FIGURE 15 EXPORT ICON

Export Options
Please select an Export format from the list

Crystal Reports (RPT)
Enter the page range tl Acrobat Format (PDF)

MS Word
® All MS Excel 97-2000

MS Excel 97-2000 (Data Only)
) Pages Rich Text Format

From: To:

OK

FIGURE 16 EXPORT OPTIONS

o Crystal Reports is a format similar to Adobe Format
(PDF). You cannot edit Crystal Reports. You will
need a Crystal Report Reader to view the report.

e Acrobat Format (PDF) is the standard that TDA uses
for many forms and documents on Square Meals and
in TX-UNPS Download Forms. The PDF is the format
used for the printed document. You cannot edit the
document unless you have Adobe Professional. You
must have Adobe Reader to see the document

¢ MS Word is not easily editable. Each string of text is
in a separate text box and the document has very
minimum margins. The Rich Text Format looks

Texas Department of Agriculture DCDV System User Manual
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exactly the same, but will open on a computer that
does not have MS Office.

JirectCenification. ipt TEXAS DEPARTMENT OF AGRICULTURE Fage 1of 3D
FPEIM 5- STATE LEVEL MATCHES
DIRECT CERTIFICATION FOR NATIONAL SCHOOL LUNCH

20152018

District Updates For July
Campus
LAST NAME  FIRST NAME  MI Sh BIRTH DATE % GRADE ADDRESS cl STATE zip MATCHDT EEFDT  ELI

FIGURE 17 MS WoORD DC LIST EXPORT

e MS Excel 97-2000 is formatted with titles (Figure
18). MS Excel 97-200 Data only is a regular
spreadsheet without the formatted titles (Figure 19).
This is the same format that the list will be if the
Download option is chosen.

=] C TEFGH T KO M NI F TOQHS [ U v WIXTY Pl AABAACTADA AR A ATAI

DirectCertification.rpt TEXAS DEPARTMENT OF AGRICULTURE Page 1 of 30
PEIM S - STATE LEVEL MATCHES
DIRECT CERTIFICATION FOR NATIONAL SCHOOL LUNCH

2015-2016

T30 ENIF. T IRl

Updates For July

FIGURE 18 MS ExceL 97-2000

A B C D E F G H | J K L M M ]
1 |District CD Number
2 001 - LAST_MNFIRST_IMI S5M  BIRTHISEX  GRADEADDRECITY  STATE ZIP MATCH EFF DT ELIG

FIGURE 19 MS EXcEL 97-2000 DATA ONLY

¢ Click the Direct Certification link in the upper left
corner to return to the Direct Certification Main
Page.

e When your direct certification activities are
complete, close the Direct Certification — Direct
Verification window.
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5.4 Download a Direct Certification List

After selecting a report parameter, click the download
button.

Report Type

* State Level Matches CE Level Matches
Report Parameters
YVear to Date List

Update Period Select Month *

View/Print Download

Figure 20 Report Type and Parameters

5.4.1 Save Messages in Different Browsers

If you are using Internet Explorer or Firefox, a pop-up
box appears asking if you want to open or save the file
(Figure 22).

e Click “Open”.

e The requested Direct Certification list will display on
the screen in Excel.

¢ In Chrome, the downloaded file will appear in the
taskbar at the bottom of the screen.

] Untitled (1)xds N l

@™ B &

FiGUurRe 21 CHROME DOWNLOADED FILE

Texas Department of Agriculture DCDV System User Manual
Direct Certification Matching
Page 25



DIRECT CERTIFICATION

You have chosen to open:
&) Untitled.xls

which is a: Microsoft Excel 97-2003 Worksheet (10.5 KB)
from: https://testdcdv.texasagriculture.gov

What should Firefox do with this file?

@ QOpenwith | Microsoft Excel (default) -
©) SaveFile

Do this automatically for files like this from now on.

o | (o]

Figure 22 Firefox Download

rIntF_'rnE't Explorer | 2 |l

What do you want to do with Untitledxls?

Size: 163 KB
From: testdcdw. texasagriculture.gov

% Open
The file won't be saved automatically.
% Save
< Save as
b o

FIGURE 23 IE DOWNLOAD DIALOG
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5.4.2 Save Downloaded File

Select File > Save As to save the file. There are more
detailed instructions and suggested naming convention
and folder structure in the Appendix (see page 53 and
56).

When saving the file, you can delete the SSN column or
redact the column to have only the last four digits of
the SSN. See page 81 in the Appendix for instructions
on redacting the SSN.

After saving the file, click the Direct Certification link in
the upper left corner to return to the Direct Certification
Main Page.

When your direct certification activities are complete,
close the Direct Certification — Direct Verification
window.

5.5 Match List Contents

Students that are listed as
matched are NEW
matches for the month.
Students previously
matched will not show on
the subsequent lists, but
their direct certification
eligibility continues until
June 30™ (end of the
school year).

The State Match List contains the names of eligible
students that have been matched by TEA to your LEA
based on the October Snapshot. The CE Match list
contains the names of the eligible students that you
have matched during the CE Upload or Individual
Search processes. If you selected a month list, it
contains the names of the students that were matched
that month. If you selected a year-to-date list, it
contains the names of all students that have been
matched.

The report contains:

e Last Name

e First Name

e Middle Initial

e Birthdate

o Sex (Gender) -- M/F
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e Grade
e Address (as provided to HHSC)

o City
e State
e Zip Code

e Match —Y if “yes”, N if “no”

e Effective Date — this is the date that the data was
loaded in the database

e Eligibility — 1 = SNAP, if there is a Y in the match
column and it is empty = TANF. Sometimes TANF
may be coded as 0.

The students on State Match List and CE Level Matches
List are not certified until you have confirmed that a
match is a student currently enrolled. The eligibility
information on the student must be entered into the
Point-of-Sale (POS) system, whether it is paper, stand-
alone or electronic. Eligibility categories, such as SNAP,
and TANF must be identified. If the household receives
both, the student is direct certified as SNAP. (See
Decision Paths p. 105)

5.6 CE Import for CE Level Matches

There are over 1 million children on the eligibility list
from HHSC that are not matched to any LEA. To ensure
that all eligible children are directly certified and
receiving meal benefits as quickly as possible, all LEAs
participating in NSLP/SBP in Texas are required to
upload current student enrollment information monthly
during the school year. This information is compared to
HHSC SNAP/TANF data to find matches.

5.6.1 CE Import Process

Before uploading data for the Import for CE Level
Matches, the data must be formatted correctly and
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saved as a CSV file. (See instructions for formatting
and saving the file in the Appendix — page 58)

Log onto TX-UNPS and the DCDV module. (See page
13). On the Direct Certification Home Page, select CE
Import for CE Level Matches.

Direct Certification Home Page

Print/Download Direct Certification Matches

CE Import for CE Level Matches

Search Page for CE Level Matches

FiIGURE 24 DC HoME PAGE MENU

If you have more
than 50,000
matches, the first
50,000 records will
be on Sheet 1. The
remaining records
will be on Sheet 2.

Select Browse to find the student enrollment data CSV
file prepared for the upload. Select Upload File. There
will be a message that the file upload was successful or
the file import failed. If the upload was successful,
follow the instructions in Section 5.2 to download the
CE-Level matches. Note: If the upload was successful,
but a month is not listed in the drop-down, that means
that there were no new matches in that month.

5.6.2 CE Match File

The response file is returned as a CSV file and the SSN,
DOB, and CE ID will have lost the formatting that was
required for the upload file. This is not a concern and
did not prevent the upload file from being matched.

The response file will indicate if students are matched
to children from households receiving SNAP and/or
TANF benefits.

Select the Data tab. Select Row 1 and then select Filter
on the Data ribbon (Figure 28). Select the arrow beside
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the word Matched and clear Select All and select Y and
OK (Figure 29). This allows you to see the matches.

]
2sh

ilas Review View Developer Acn
da| Connections A-'r ﬁ
- Z|A
Fllter
f?ﬁu:hranced

*

Connections Sort & Filter

FIGURE 25 DATA TAB > FILTER

E F G
GENDE ~ |CE ID |~ |SITE IO ~ MAT!
F

4] sotAtoz

FlZ| sotztoa

Sort by Color

=
M| *

M

F Text Filters

::: earch P
M

E

E

=

E

=

E

=

M

:;1 [ OK ]| Cancel

FIGURE 26 FILTER A COLUMN

e Any students that are new matches for the month
will have a “Y” in the Matched column.

o The Eligibility column will contain a “1” if the match
is based on SNAP eligibility.

e If there is a “Y” in the Matched column and the
Eligibility column contains a O or the cell is blank,
the match is based on TANF eligibility.
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A
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A
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FIGURE 27 RESPONSE FILE FORMAT

1

<< <<

1
0
0

New matches must be confirmed for direct certification,
identified in the POS system, and tagged as either
SNAP or TANF. The report must be saved according to
record retention guidelines. The SSN data can be
redacted or deleted from the report before printing or
saving.

After saving the file, click the Direct Certification link in
the upper left corner to return to the Direct Certification
Main Page.

When your direct certification activities are complete,
close the Direct Certification — Direct Verification
window.

5.7 CE Search for Individual Matches

Sounds like
searches for
variations in
spelling.

The CE Search for Individual Match function allows you
to search for individual records in the unmatched pool,
as well as the all records that have been previously
matched to your LEA. The advantage of the individual
search is that you can search based on just SSN and
DOB, or on name and DOB. There is also a “sounds”
like feature for first and last names that allows for
different spellings of names, such as John and Jon.

Log onto TX-UNPS and continue to the DCDV module.
(See page 13). On the Direct Certification Home Page,
select CE Search for Individual Matches.

e Select Unmatched if you want to search in just the
records that have not been matched to any LEA.
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o Select All if you want to search all eligible students
that have been matched to your LEA.

e Enter SSN (9 digits with no dashes) and the DOB

(mm/dd/yyyy)
OR
e Enter Last Name, First Name and Birth Date
(mm/dd/yyyy).

e Select Search or Select Sounds Like to search for
the possible match.

Search Page for CE Level Matches
Main Menu
* unmatched All
Enter SSN:
Enter Birth Date: (MM/DD/YYYY)
Search Reaset
OR
Enter Last Name:
Enter First Name:
Enter Birth Date: (MM/DD/YYYY)
® Search Sounds Like(First Name and Last Name)
Search Reset
FIGURE 28 CE SEARCH FOR INDIVIDUAL MATCHES

If the system finds a new match, you will see the
student’s name and information on the screen. Select
View to see the details. Select Match to confirm that
this record is a match to the student enrolled in your
school. You can print or export the match. The Excel
export looks like the PDF print version. It does not
export as a spreadsheet in columns and rows.
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Ref, ID# Social Security # Student’s Full Name Birth Date Matched
View 7882299 Sl b A — 9/6/2007

1
FIGURE 29 INDIVIDUAL SEARCH RESULT

Direct Certification Student Details
Student’s Full Name: S
Sodlal Security #: *EE_EX.9I5]

Reference ID: 7882299

Eligibility: 1

Birth Date: 9/6/2007
Address: A
Matched:

Match nmatt Print Return

FIGURE 30 MATCH SCREEN

5.8 Direct Certification Reporting

You must report the number of students enrolled on the
last day of October who have been directly certified on
the Verification Report in Section Three (see Verification
Report in Appendix page 100).

All students certified from July 1% through end of
October are counted. This includes students confirmed
on the State Match lists and matched on the CE Upload
Response files. Students that are certified by
association are included in the count. If a student has
presented an eligibility letter and you were able to
certify that information either through the DC module
or contact with the HHSC office, than that student is
also counted.

LEAs participating in special provision programs
(Provision 2 and CEP) may have alternate methods for
reporting Direct Certification numbers. Please check
with your ESC.
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DIRECT CERTIFICATION

If you have questions about how to do complete the
Verification Report, please contact your regional
education service center (ESC).
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6. Quick Overview — Direct Verification

What is Direct Verification?

Direct verification is using records
from public agencies to verify income
or program participation.

Direct Verification must be completed
before asking a household to provide
documentation.

Why use Direct Verification?

e Reduce workload for school district
staff

e Reduce burden and intrusion on
families selected for verification

¢ Reduce number of non-
respondents and rate of benefit
termination for non-response

When is the DV module open?

The DV module opens for LEA use on
October 1° and closes on December
1t

How do | use it?

Check the names of children eligible
for free or reduced price meal benefits
listed on the approved application in
the DV module.
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Direct Verification Process and Policy

Verification
Verification is the process for reviewing the eligibility
determination for a free or reduced-priced household
application submitted for the NSLP and SBP. Refer to
the Administrator’s Reference Manual, Section 6:
Verification for more detailed information.

6.1 Direct Verification

Direct Verification is the use of public records to verify a
student’s eligibility for free or reduced price meals when
verification of a student’s eligibility is required.

You are required to verify applications. You are not
required to do Direct Verification (DV), but there are
benefits in doing this process. DV streamlines the
verification of applications — saving you time and effort.
By increasing DV, the number of application that you
must verify by contacting the household is decreased. If
any student in the household is identified using the
DCDV module, all students in the household are directly
verified, and there is no need to request additional
information from the household.

The Texas Department of Agriculture (TDA), the Texas
Education Agency (TEA), and the Texas Health and
Human Services Commission (HHSC) have developed a
database that allows you to match the nine-digit
Eligibility Determination Group (EDG) number to
student in the household.

For children who qualify for Medicaid of CHIP, the
database will report whether student is eligible for free
or reduced-price meals.
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Direct Certification allows you to match SNAP or TANF households.
Direct Verification will allow you to verify household participation in
SNAP, TANF, Medicaid, or the Children’s Health Insurance Program
(CHIP), but there is no indicator for what program

6.2 Verification Time Period

The Verification Official can verify an application as
soon as it is approved — before the official start date of
October 1. On October 1, you must determine the
number of verifications to be conducted for the school
year, and begin the verification process. If you conduct
Direct Verification, you must complete it before asking
a household to provide documentation. Verification
must be completed by November 15" on students who
were enrolled the last operating day of October.
Verification results are reported on the Verification
Report in TX-UNPS by February 1%.

6.3 Direct Verification Policy

Only the free and reduced-priced applications are
verified. You must not verify the applications of
students if the eligibility was made in one of the
following ways:

¢ Students that are directly certified

¢ Students living in residential child care institutions
(RCCI)

e Students attending a school that administers the
Community Eligibility Program (CEP) or Special
Assistance Provision 2 (P2) with the exception of P2
schools establishing their base year
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DIRECT VERIFICATION

¢ Students attending a school that participate in the
Special Milk Program only

e Schools attending a school where there is no
separate charge for food service and no special cash
assistance claimed

If you determine through Direct Verification that a
student is categorically eligible for SNAP or TANF, all
students in the household are extended eligibility.
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7. Direct Verification
7.1 Log-on to DV Module

Log onto the DCDV module (see page 13). Click the
Direct Verification link (second title from the left) to
proceed to the Direct Verification screens.

Direct Certifica

Direct Certification Direct Verification

FIGURE 31 DIRECT VERIFICATION LOG-ON

Note: Throughout the direct verification module, the
search results and match results screens will display the
Case/EDG number as a numeric field, excluding any
preceding zeroes. However, both manual and batch
upload searches can be performed with any preceding
zeroes.

7.2 Manual Search Case/Eligibility Determination Group (EDG) Number

On the Direct Verification main page, select “Search

Page”.
rcch P
Print Direct Verification
istri mpor

FIGURE 32 DIRECT VERIFICATION HOME PAGE

Texas Department of Agriculture DCDV System User Manual
Direct Verification
Page 39



Search Page for Direct Verification

Select Search Criteria Case/EDG Number Student Information

Main Menu

FIGURE 33 DIRECT VERIFICATION SEARCH PAGE

Select the “Case/EDG Number” radio button.

Search by Case/EDG Number

& unmatched O All

Enter Case/EDG Number:

FiIGURE 34 DIRECT VERIFICATION CASE/EDG SEARCH CRITERIA

To search only direct verification records that have not
been matched by your organization, select the
“Unmatched” radio button. To search all direct
verification records, including those already matched by
your organization, select the “All” radio button.

e Enter the Case/EDG (Eligibility Determination Group)
Number into the provided text box.

o Click Search. (Clicking the “Reset” button will clear
any information you have entered in the Case/EDG
Number field.)

If no records exist that match the entered search
criteria, you will see the message “No matches found”.
Click the Back button to return to the direct verification
search screen.

Texas Department of Agriculture DCDV System User Manual
Direct Verification
Page 40



Rl T Case/EDG

Number

ima 9224519 ouammm
vaw 9260597 (D
1152429 gemame

Social Security @ | Student’s Full Names Birth Date L_”IEL"I'_I_‘ Verifiod For | Matched
= e-=e-723l .

""" ~6105 . ]

***** B676 L

FIGURE 35 DIRECT VERIFICATION SEARCH RESULTS

Once a record is matched,
it will only appear in
subsequent searches if you
select “All” in the search
criteria. (Selecting
“Matched” on a search
screen will exclude this
record from the results.)
In addition, the matched
record will no longer
appear in searches
performed by other
contracting entities.

If one or more records exist that match the entered
search criteria, the results will display on the screen.

Direct Venfication Student Details
Student's Full Name: TR
Social Security £: =EF_*=*_8507

Verified For: Reduced

Reference ID: PRp—

Case/EDG =: L]

Student Details

Birth Date: 1/8/2002

Address:
County: HARRIS

Matched:

FIGURE 36 DIRECT VERIFICATION RECORD DETAILS

To access a specific record, click the “View” link to the
left of the desired record.

To indicate that a record is being used to directly verify
a student, click “Match”. Your CE ID will then display in
the “Matched” field.

To print the record, click “Print”.

If you click “Match” on a record, and subsequently
realize this record should not be matched, you can click
“Unmatch”. Your CE ID will be removed from the
“Matched” field.

To search for another record, click “Return” to return to
the direct verification search results screen.
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DIRECT VERIFICATION

7.3 Manual Search without Case/EDG Number

On the Direct Verification main page, select “Search
Page”.

Search Page
Print Dir Ver

istri

Figure 37 Direct Verification Home Page

Select the “Student Information” radio button to search
for records without entering a Case or EDG (Eligibility
Determination Group) number.

Select Search Criteria O case/EDG Number @ Student Information

Search by Student Information
®unmatched OAll

Enter SSN: | ]
Enter Birth Date: | ]

[ Search | [ Reset ]

OR

Enter Last Name: |

Enter First Name: |

Enter Birth Date: :

Select Student County Residence (Optional): |AII Counties v

@ search O Sounds Like (First Name Only)

[ Search | [ Reset |

FIGURE 38 DIRECT VERIFICATION STUDENT INFORMATION SEARCH
CRITERIA
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7.3.1 Search Parameters

To search only direct verification records that have not
been matched by your organization, select the
“Unmatched” radio button. To search all direct
verification records, including those already matched by
your organization, select the “All” radio button.

Enter the desired search criteria into the provided text
boxes. (For SSN, do not include dashes. For Birth
Date, enter in the format mm/dd/yyyy.)

You can search by either social security number (SSN)
and birth date, or by last name, first name and birth
date (and county if desired). When using the second
set of search criteria, you can also include a “Sounds
Like” search on the first name. Selecting this option
will result in matches where the last name and birth
date fields match, but the first name has a different
spelling (ex. Marisa vs Marissa).

Click Search.

If no records exist that match the entered search
criteria, you will see the message “No matches found”.
Click the Back button to return to the direct verification
search screen.

If one or more records exist that match the entered
search criteria, the results will display on the screen.

7.3.2 Print an Individual Direct Verification Record

Follow the steps to perform a manual search and then
select the desired record by clicking “Details”.
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Click “Print”.

Direct Venfication Student Details

Student's Full Name: TGN
Social Security £:  F**_**_ggQ7
Verified For: Reduced
Reference ID: 1134628
Case/EDG =: R

Student Details
Birth Date: 1/8/2002
Address:
County: HARRIS
Matched:

FIGURE 39 DIRECT VERIFICATION RECORD DETAILS

Click the Printer icon |§| (under the Direct Certification

link) to print the record.

e I ] 1/1
+pt_DirectVerification Detail it TEXAS DEPARTMENT OF AGRICULTURE
DIRECT VERIFICATION FOR NATIONAL SCHOOL LUNCH
100472011
Last Name: OAWTON
First Name: CHRISTIAN
Middle Name:
SSH: wxx_ax_GEOT
Birth Date: 01/08/2002
Address: 22204 WEBB ST
City: HOCKLEY
State: TX
Zip: 77447
Case/EDG Number: 3,007,985.00
Matched by CE ID: 00528
Eligible: Reduced

FIGURE 40 DV INDIVIDUAL RECORD PRINT SCREEN
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A pop-up box appears asking for the page range.
Select “All” and click “OK”.

Another pop-up box appears asking if you want to open
or save the file. Click “Open”.

The list will display in PDF format. Click the Printer icon
on the page.

Close the PDF window.

Click the Direct Verification link in the upper left corner
to return to the Direct Verification Main Page.

7.4 Batch Upload Search of Direct Verification Records

All fields are required
when uploading a batch
file. In order to result
in a successful match,
all fields in the record
must match.

Before starting the Batch Upload Search Process, the
upload file must be formatted. The uploaded file must
be in CSV format and must not be larger than 4 MB.
The following table lists the fields that must be included
in the file and their order. All fields are required. The
uploaded file should not contain a header row. (For
more information on formatting the file, see page 58 in
the Appendix.)
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Case/EDG Number

Social Security
Number

Last Name

First Name

Birth Date

County Code

Meal Code

CE ID

Varchar

Numeric

Alphanumeric

Alphanumeric

Alphanumeric

Numeric

Character

Numeric

Variable length
field;

Do not include
special
characters;
Preceding zeros
can be included
or excluded

9 digits;
Do not include
dashes

Variable length
field;

Not case
sensitive

Variable length
field;

Not case
sensitive

mm/dd/yyyy

3-digit county of
residence (1%
three digits of
county-district
code assigned
by TEA)

F for Free or
R for Reduced

5-digit ID
assigned by TX-
UNPS

DIRECT VERIFICATION

n

11111

111223333

Doe

John

10/04/1997

057

00528
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DIRECT VERIFICATION

Once the file is formatted correct, logon to the DCDV
module. On the Direct Verification main page, select
“District Import”.

Click here for Help If you need further assistance, please call CNPIMS at (877) TEX-MEAL. Please do not send questions by email.
The file you import must be a comma delimited file with the suffix of (.csv). The file must not be any larger than 4MB

| |[ Browse.. |

FIGURE 41 DV UPLOAD SCREEN

Click “Browse” and locate the file you wish to upload.
Click “Upload File”.

A pop-up box appears asking if you want to open or
save the file. Click “Open”. (If you do not get the
Open/Save dialog box, pop-ups may be disabled. Click
the associated link to “Enable” pop-ups.)

File Download

Do you want to open or save this file?

E-;j Mame: d__TDA_test CNPIMS_DV_Import_Save_Results.csy
4, Type: Microsoft Office Excel Comma Separated Values Fils
From:  testdcdv.texasagriculture.goy

[ Open ][ Save ][ Cancel |

While files from the Intemet can be usehul, some files can patentially
harm your computer. If you do not tist the source, do not open or

save this file. What's the risk?

FIGURE 42 DIRECT VERIFICATION BATCH UPLOAD RESPONSE
PopP-UpP SCREEN

The list containing the results of the batch upload will
display on the screen in Excel.
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DIRECT VERIFICATION

Pl A e ¢ | o | E [ F [ 6 | W [ 0 [ 3 |
edgnum ssn lastname firstname birthdate county  meal ceid siteld

=

matched

FIGURE 43 DIRECT VERIFICATION BATCH UPLOAD RESULTS

The following table lists the fields that will be included

in the results file and their order.

be included in the file.

A header record will

10

Case/EDG Number
(titled edgnum)

Social Security
Number
(titled ssn)

Last Name
(titled lastname)

First Name
(titled firstname)

Birth Date
(titled birthdate)

County Code (titled
county)

Meal Code
(titled meal)

CEID
(titled ceid)

Site ID
(titled siteid)

Matched indicator
(titled matched)

Numeric

Numeric

Alphanumeric

Alphanumeric

Alphanumeric

Numeric

Character

Numeric

N/A

Character

Variable length field;
Any preceding zeros will be
excluded

9 digits;

Does not include dashes

Variable length field

Variable length field

mm/dd/yyyy

3-digit county

F for Free or

R for Reduced

5-digit ID assigned by TX-UNPS

Will not contain a value

Will contain a Y if the record
was matched; Will contain an N
if the record was not matched

11111

111223333

Doe

John

10/04/1997

057

00528
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DIRECT VERIFICATION

7.5 Saving the File

See page 53 for instruction on saving a file in different
versions of Excel.

7.6 To View or Print a Listing of All Direct Verification Matches

On the Direct Verification main page, select “Print
Direct Verification”.

Click here for Help If you need further assistance, please call CNPIMS at (877) TEX-MEAL. Please do not send questions by email.
To get the complete Direct Verification list for the district, click on View/Print or Download button.
To get updates to the Direct Verification list, please select the appropriate set of updates and Click on View/Print or Download button.

[ viewPrint | [ Download |

Figure 44: All Direct Verification Matches Print Screen

Select “View/Print”. The list containing all Matched
direct verification records will display on the screen.

TEXAS DEPARTMENT OF AGRICULTURE

DIRECT VERIFICATION FOR HATIONAL SCHOOL LUNCH
100472011

m
(]
e
o
=

First Name hfiddle Name Last Name DoB Courity hdeal

5
g.
g

Figure 45: Direct Certification View/Print Screen

Click the Printer icon (under the Direct Certification
link) to print the list of students.

A pop-up box appears asking for the page range.
Select “All” and click “OK”.

Another pop-up box appears asking if you want to open
or save the file. Click “Open”.
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The list will display in PDF format. Click the Printer icon
on the page.

Close the PDF window.

Click the Direct Verification link in the upper left corner
to return to the Direct Verification Main Page.

When your direct verification activities are complete,
close the Direct Certification — Direct Verification
window by clicking Exit in the upper right corner.

7.7 To Download a Listing of All Direct Verification Matches

On the Direct Verification main page, select “Print
Direct Verification”.

rch P
Print Direct Verification
1Istrict Impor

To get updates to the Direct Verification list, please select the appropriate set of updates and Click on View/Print or Download button.

View/Print ] [ Download

FIGURE 47 ALL DIRECT VERIFICATION MATCHES PRINT SCREEN

o Select “Download”. A pop-up box appears asking if
you want to open or save the file.

e Click “Open”. (If you do not get the Open/Save
dialog box, pop-ups may be disabled.

¢ Click the associated link to “Enable” pop-ups. Then
click Download again.
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¢ The list containing all Matched direct verification
records will display on the screen in Excel.

- -— B | C | D | E i B | G [P | .
] |EDG 55N First Name Middle Name Last Name DOB County Meal  District Num

FIGURE 48 DIRECT VERIFICATION DOWNLOAD SCREEN

See page 56 for instructions on how to save the file in
different versions of Excel.

After saving the file, click the Direct Verification link in
the upper left corner to return to the Direct Verification
Main Page.

When your direct verification activities are complete,
close the Direct Certification — Direct Verification
window by clicking Exit in the upper
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8. Acronyms

CD code:
CE:
CEP:
CSsvVv:
DC:
DCDV:
DOB:
DV:
EDG#:
FERPA:
FND:
HHSC:
IE:
LEA:
NSLP:
PDF:
PEIMS
PII:
POS:
RCCI:
SBP:
SNAP:

SNP:
SSN:
TANF:
TDA:
TEA:

TX-UNPS:

USDA:

County district identification code assigned by TEA
Contracting Entity

Community Eligibility Provision

Comma Separated Values

Direct Certification

Direct Certification Direct Verification

Date of Birth

Direct Verification

Eligibility Determination Group Number

Family Educational Rights and Privacy Act

Food and Nutrition Division of the Texas Department of Agriculture
Health and Human Services Commission

Internet Explorer

Local Education Agency

National School Lunch Program

Portable Document Format

Public Education Information Management System
Personal Identifiable Information

Point-of-Sale

Residential Child Care Institution

School Breakfast Program

Supplemental Nutritional Assistance Program (formerly called Food
Stamps)

School Nutrition Program

Social Security Number

Temporary Assistance for Needy Families

Texas Department of Agriculture

Texas Education Agency

Texas Unified Nutrition Programs System

United States Department of Agriculture
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9. What is the difference between DC and DV?

Direct Certification

Direct Verification

Available all year

Available only during Verification
(starting October 1)

Required to conduct monthly during
the school year

May use DV before contacting household
for documentation

All enrollment must be run through
the system

Only students on the applications
selected for Verification may be run in
the system

Results a “Match” = student and all
household members are FREE

Results a “Match” = student and all
household members are verified.
Eligibility does not change.

Data from HHSC is matched by TEA
to PEIMS

Data comes directly from HHSC

Cannot search by EDG numbers
provided on applications

Can search EDG numbers provided on
application
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10. Folder Structure

¢ In the My Documents window, right click and
choose New Folder. Figure 47

View L
Sat by 3
Group by "
Refresh

Custornize this folder...

Paste
Paste shorteut

& Shared Folder Synchronization b
I
pmmis Tl

FIGURE 49 NEW FOLDER

¢ Name the folder Direct_Certification_Data or DCDV
Figure 47

Documents library
Includes: 2 locations

=
Name

[] My Data Sources
. My Received Files
My Shapes
| || Direct Certification Data__|

FIGURE 50 1sT FOLDER NAME
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Inside of the Direct_Certification_Data folder, right

click to make a new folder. Name it DCDV__ followed
by the school year.

Documents library

DC_2015-2016

FiGure 51 DC_ScHooL_YEAR_FOLDER

e Inside of this folder, make 3 more folders — one for

Matched_Lists , another for DC_CSV_Files and one
more for Direct_Verification.

You will need to make the Direct
Certification Data folder just once. Make a
new DCDV-(school year) folder and the

folders inside it each August to start the
new school year.
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11. How to Save a File as a CSV File
11.1 How to Save a File in Excel in 97-2003:

¢ Once the file opens in Excel
e Click “File > Save As”.

e Select a proper destination directory (either your
computer hard disk or external media) to download
the list of eligible students for Direct Certification.
(See page 53 for recommended folder structure)

e Enter a file name.

o If saving as a comma delimited file, click the “Save
as type” drop-down and select “CSV (Comma
delimited)”.

e After clicking Save, a pop-up box appears asking
about feature compatibility. Click “Yes” to continue
saving as a CSV file.

11.2 How to Save a File in Excel 2007 or Later

¢ Once the file opens in Excel, click the Office button
(very top icon at the left hand corner) and select
“Save As”.

e If saving as an Excel file, click “Excel Workbook.”

e Select a proper destination directory (either your
computer hard disk or external media) to download
the list of eligible students for Direct Certification.
(See page 53 for recommended folder structure)

o If saving as a comma delimited file, click “Other
Formats”.

o A “Save As” window will appear.
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¢ Click the “Save as type” drop-down and select
“CSV (Comma delimited)”.

e Select a proper destination directory (either
your computer hard disk or external media) to
download the list of eligible students for
Direct Certification.

e After clicking Save, a pop-up box appears
asking about feature compatibility.

¢ Click “Yes” to continue saving as a CSV file.
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12. Formatting Excel File for CE Import Process

If you receive student enrollment data as an Excel
spreadsheet it must be re-formatted as a comma
delimited or comma separated (CSV) file before it can
be used in the CE Upload process for Direct Certification
or Direct Verification.

TDA recommends that you use the file structure
described on page 53.

12.1 Save Copy of File

Save another copy of the file to reformat. A good file
name would include the month and year, a description
of what the data is, CSV (so it’s easy to distinguish
from the original file) and the date that the file was
prepared.

Example:
Month_SchoolYear_ Student Enrollment CSV_YYMMDD
Aug_2016_Student_Enrollment_CSV_150806

Writing the date as YYMMDD makes it easier to sort
files by date created.

12.2 Right Columns/Right Order
Check that the columns are in the correct order:

e A - Social Security Number (SSN)
e B - Last Name

e C - First Name

e D - Date of Birth (DOB)

e E - Gender

e F - CE ldentification Number
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If there are any additional columns, delete the column.
Select the letter at the top of the column, right-click
and select Delete (Figure 55).

& Cut
o copy
[, Paste Options:
&=
Paste Special...
Insert...
Deelete...
Clear Coptents
Filtgr r
Sort r
- [Insert Comment
% Format Cells...
Pitk From Drop-dewn List...
Define Mame...
&, Hypenink...

FIGURE 52 DELETE COLUMNS

12.3 Format Social Security Number

e Select Column A (SSN)

¢ Right-click and select Format Cells (Figure 56)

iy - —
i [Toar 4 [
2 | 798052 con !
3 [2482001 @ asteOptions:
| 4 [939642 \
% %:?E:: Paste Special..,
I Za‘E“‘i Insest q
[ 8 |230E4  peee |
i 255E+H Clear Coptents |
10 | 264E+H 2
o 5 Format Cells..
2 BOE+
% 3..'EE'H Lolwmn Width... i
i3 [307Es e |
| 14 | 316E+ Unhide E
15 | 3 ARF+OAISINTH — SHATRA |

FIGURE 53 FORMAT CELLS
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o Select Custom and under Type (were the word
General is) enter 9 zeroes (Figure 57). Select OK.

Forma Call |f|lﬂ‘|
tumber | Abgrenera | Font | Berer | P8 | Presechon |

Category:

Govar ol | Gample

hurnbser DOPRATEY

Al ey !

Yo 000200000

Parcenitsgs -
[p—

Sopnbis 00

Texit

i
AL LR
SR E— | | e 1its.e0
», 220 [Fed](r, e
o, w00 i, e, 00)
», 0. 00_k[Redi{e, »80.00)
dm,w e e, ]
ELA (el {sa, & @) i

il | peesw |

Tvpes Tee rornber Tormst ok, waing o of e ENEEDNG COces 55 5 Fiar g point.

[ o= || coecd |

FIGURE 54 SSN FORMAT

12.3.1 Find and Replace

If there are dashes or hyphens in the SSN, remove
them.

e Select Column A

e Go to Find and Select on the Home tab on the right
side of the screen (Figure 58)

e Select Replace from the drop-down list
e Type a dash (-) in the Find what field
¢ Leave the Replace with field blank

e Select Replace All. Select Close.
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33 @ g e 90

h-m'l D-Eh!'lt Formal Sol & Fhelh Siriorthinaugh  Sgseak
= Tl = Fier - Crih EH.'l:lnn
Celly Exiting ._n Firid . A
% Beplace
= Goio..
0 To Specil., ==
R 5 1 . |
Find and Replsce ’ !
Commantsy -
— .}
| B IH“ Congddnyngd Fomating
P vt . Copitanid
e Dista Yalidation
o Sebedl Diajedy
By S Pane
| repace ) | | mecsce | | mpeal | [ podwemt | [ cose |

FIGURE 55 FIND AND REPLACE

12.4 Format Date of Birth

e Select Column D. (DOB)

¢ Right click and select Format Cells. Select Custom
and enter mm/dd/yyyy under the word Type (Figure
59).

Fort | Border | Fl | Prosecs

FIGURE 56 FORMAT DOB
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12.5 Format CE ID

e Select Column F (CE ID) .

e Right-click and select Format Cells. Select Special >
Zip Code (Figure 60).

¢ Note: You may have to change the locale to English
(U.S.) to get the 5-digit zip code.

Forrmat Cells

Number | Migrment | Font | Border | Fd

gil:m:nr:
General
Humber
CLrmency

Accounting
Date

T

FIGURE 57 FoOrRMAT CE ID
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13. Import Text File to Excel
If your data has in a text (.txt) file format, you can
import that into Excel with a few simple steps.

e Open a new Excel workbook. Select the Data tab.

e On the Data ribbon, select From Text from the first
group Get External Data (Figure 70).

If you open a
response file in i d9- =
Firefox, it will

Home Insert Page Layout Formulas

usually open as a 5 5 g) =emeren a3
text file in Notepad. tom Other | Existing | Refresh Z| sot | Filt
Access Sources - Connections All =

Import it into Excel

Get Extérnal Data Connéctions
so that you can use FIGURE 58 GET EXTERNAL DATA
the data.

¢ Find the text file and select Import.

This opens the Text Import Wizard — Step 1 of 3 (Figure
71).

¢ Check that these two options are correct:
e Delimited is selected

e Start import at row: 1

Text Import Wizard - Step 1 of 3 ? =

The Text Wizard has determined that your data is Delimited.
If this is correct, choose Next, or choose the data type that best describes your data.
Original data type
gase the file tupe that best describes your data:
- Characters such as commas or tabs separate each field,
Fixed width - Fields are aligned in columns with spaces between each field.

Start import at row: |1 = || File origin: 437 : OEM United States

=]

Preview of file H:\My Documents\DClhdisd 8-25.csv.

ESN Last Name First Name DOB o
—

- FEERF

3

FIGURE 59 IMPORT WIZARD STEP 1
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e Select Next.

This opens Text Import Wizard — Step 2 of 3.

o “Un-select” Tab and select Comma (Figure 72).

. " . . . . . .
Text Import Wizard - Step 2 of 3 &E

This screen lets you set the delimiters your data contains, You can see how your textis affected in the preview
below.

Delimiters
Teb
Semicolon Treat consecutive delimiters as one

] Ce
Space

Other: |:|

Data preview

SN, Last Name,First Name,DOB,

[ cancd | [ <gack | [ etz | [ Ensh

FIGURE 60 IMPORT WIZARD STEP 2A OF 3

This will put lines between the columns.

Text Import Wizard - Step 2 of 3 (2] = ]

This screen lets you set the delimiters your data contains. You can see how your text is affected in the preview
below.

Delimiters

e

Semicolon Treat consecutive delimiters as one
Comma

Space
Pigbe: [ ]

Data preview

SH st Neme Fizsc Name poz

-

]

A
1

i

[ ) (<wa ) (e ][5 )

FIGURE 61 IMPORT WIZARD STEP 2B OF 3

e Select Next
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e The first column is SSN. For the Column Data
format, select Text (Figure 74).

Note: If you are not going to keep SSN in the file, you
can select Do not import column (skip).

r N
Text Import Wizard - Step 3 of 3 |2 e

This screen lets you select each column and set the Data Format.

Column data format

General

‘General' converts numeric values to numbers, date values to dates, and all
remaining values to text,

Date: | MDY | e

() Do not import column (skin)

Eeperz) Deperay  Lepers)  Fepera)

23t Name IFirst: Hame POB |

[l »

<l ¥

[ concel ][ <Back || wewts | [ Enmsh |

FIGURE 62 IMPORT WIZARD STEP 3 OF 3

¢ You can format the DOB and CE ID as text, but it is
not necessary to do so unless your POS system
requires them to be formatted in a certain way.

e Select Finish.
e Add a row for column headings if you prefer.

e Save the file and close.
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14. Making the Download File User Friendly
The Download option of the State Match and CE
Matches gives you more control of your data. You can
make the file look exactly the Print/Download copy if
you want.

14.1 Formatting an Excel Spreadsheet

Save the file before you start and frequently whole you
format it. You will need to format the document to help
you read it on screen and so that it will print a legible
copy. The instructions for formatting the document are
very similar for all versions of Excel.

14.1.1 Resize Columns

e Select all of the columns by clicking on A at the top
of the 1st column. Hold down the left button as you
move the mouse over letters over the rest of the
columns to select them (Figure 66).

id9= T DCprrtpage [Read-Only] [Compatibdity Mode] - Micresoht Excel —

7

FIGURE 63 SELECT COLUMNS

e On the Home tab in the Cells group on the right,
select the arrow beside Format. Select AutoFit
Column Width (Figure 68).
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Fage Layout Farmulas Data Review View

FIGURE 64 EXCEL TABS > HOME

T I AutoSum ~ ﬂ
= (] Fin -

Sort &
&2 Clear~  Fijter -

cells | ot size
+C  Row Height...
AutoFit Row Height

Py

- T e

AutoFit Column Width
Default Width...

Visibility
Hide & Unhide 3

Organize Sheets
Rename Sheet
Move or Copy Sheet...
Tab Color »

Protection

&y Protect Sheet..

Lock Cell
[ Format Cells...

FIGURE 65 AuTo-FIT CoLUMN WIDTH

14.1.2 Page Set-up

The following instructions will format the file to print
correctly and add a header and page numbers.

In Excel 2003, select File > Page Setup from the menu
to open the Page Setup dialog box.

In Excel 2007/2010/2013, select the Page Layout tab
and select the arrow in the bottom right of the Page
Setup group (Figure 69).
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FIGURE 66 PAGE SETUP

Orientation and Scaling

¢ On the Page tab, select Landscape for
orientation.

¢ On Scaling, select Fit To and enter a 1 for pages
wide and delete the number for pages tall. Leave
that field blank. This will put all the columns on
one page, but will print as many pages for the
rows as needed. Do not click OK yet.

Page Setup 1 i =)
[ Page | Margns | HesderFooter | sheet

Orentaton
@ O Poryrat Om
Scalng

) Adustto: 300 <5+ % normal sire
© Btto: E| i~ page(s) wide by - wl

Paper sige:  Letter (8.5x 117
Print gualty: 600 dp

HE

Frst page number:  Auto

[ emt.. | [proterevien | [ govors... |

o) (o)

FIGURE 67 PAGE TAB PAGE SETUP DIALOG
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Margins
Select the Margins tab.

You will need at least 1-inch margin at the top for the
header (Figure 71). Do not click OK yet.

Page Setup m
Page | Margins | HeaderfFooter | Sheet |
Top: Header:
1 0.3
Left: Right:
0.7 |5 S 0.7 |5
Bottom: Footer:
0.75 4 0.3
Center on page
[T Horigontally
[C] vertically
ok [ cace |
=
FIGURE 68 MARGINS TAB
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Header

Select the Header/Footer tab. Select Custom Header.

Page Setup T - 2 R
| Page [ margns | HesderFooter | sheet |

7] pifferent odd and even pages
7] ifferent first page
[¥] Scale with document
7] Algr with pages margng
| print.. | | PontPreview | | @etons.. |

Click in the Center section (Figure 72).

R e —

Header  —— | —

r y
T Frerrant bk sedect the Bewt, Seen choose S Formak Teot button.
To insert & page rumber, date, e, fe path, flenams, o i name: poation the

[neper N PO iR the et boor, then choose e SRDroprate bution.
To insert pcture; press T Insert Pictre Bution, To format your pichre, place the
urser in e edit oo and press the Format Pactune butioe.

A bR @6 @EE @

Lt section: Caner gection:

bt

FIGURE 69 HEADER CENTER SECTION

The following information is how the heading looks on
the Print/View selection. You may use this as the
heading. The information inside of the <> should be
revised for the specific document.
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State Level Matches

Texas Department of Agriculture
PEIMS — State Level Matches
Direct Certification for National School Lunch
< School Year=
<Year to Date> or Update for <Month>
<Date of Eligibility>

CE Level Matches

Texas Department of Agriculture
CE Level Matches
Direct Certification for National School Lunch
< School Year>
<Year to Date> or Update for <Month>
<Date of Eligibility>

Number of Pages
e Click on the Right section.
o Type the word Page with a space after it.

¢ Click on the rectangle with the pound or number
sign.

e Enter a space.
e Type the word of with a space after it.
e Click on the rectangle with 2 plus signs (Figure 73).

e Click OK
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Heades :tr — L =)
[ reader |

To format text: melect the bext, then choose the Formad Text button,

To irsert & page number, date, Sme, fle path, Sensme, or tab neme: postion the
inserSon poant in the edit bow, then choose the sporopriate button,

T ingert perture: press e Ingert Pictune button. To format your poiune, place the
U i e edit oo o press the Formal Paiune bution.

sloslee eme @s

Lt seston: Eaniter Secior: Bight secten:
l - ‘ - Fage &[FPaga] vf&l"m:} .

] (o]

FIGURE 70 PAGE NUMBER

Repeat Column Headings on Each Page and add
Gridlines

e Select the Sheet tab.

¢ On Rows to repeat at the top, select the red arrow
to the right (Figure 74).

Page Setup - } ] =)
- = = _
[ page | Margns | HeaderfFooter | Sheet |
Print grea: |
Print tties
Rows to repeat at top: |
Columns to repeat at left:

#[F @

FIGURE 71 REPEAT Row (As COLUMN HEADINGS)

e Click on the 1 to the left of the first row (or the
row that contains the column headings). This will
repeat the column headings on each page.

e Click the red arrow in the dialogue box to close it
(Figure 75).
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FIGURE 72 SELECT Row FOR COLUMN HEADINGS

¢ Check the box in front of Gridlines. This will print
lines between columns and rows.

e Select OK.

e Save the file.

Pgesens o 0 =)
| [-pege [ margns | resderFooter | et |
| F\*htarea:|
Print titles
Rows torepeatattop: | §1:§1
Columns to repeat at left: |
Comments: |(None} El
[ Draft quaity Cell errors as: |dml.ayed El
7] Row and column headings :
Page order |
o=
() Over, thendown  |==Rz=H==
EERE [SHEE
(o ][ conel ]
FIGURE 73 GRIDLINES
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15. Correcting Invalid Data
Column J in the response file for the CE upload

indicates if the record has “invalid data”. If there is an
X in the column J for that row, that record was not
matched. You need to correct and upload it again or try
it in the individual search.

The easier way to locate the problem that cause the
Invalid Data notice is to have 2 files open at the same
time — 1 in Excel and 1 in Notepad.

e Save the response file with the invalid data first with
a different name than the original downloaded file.
Include “invalid_data” in the file name.

e Leave the response file with the invalid data opened
in Excel.

e Locate the name of the original response in the file
list window.

¢ Right click on the file name and select Open with ...
Notepad (Figure 77).

Open

Print

Edit

SkyDrive Pro

7-Zip »
% Convert to Adobe PDF
# Convert to Adobe PDF and EMail

Open with 2 Firefox

@

Internet Explorer
Microsoft Excel
Notepad
WordPad

U Scan for threats...

HELE

Always available offline

Restore previous versions

=

Send t »
encte Cheose default program...

Cut
Copy

Create shortcut
Delete

Rename

Properties

FIGURE 74 OPEN WITH NOTEPAD
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15.1 How to Filter

The file with invalid data is opened in Excel. We will use
a filter to help locate the issue.

e Select the number for the row that has the column
headings.

e Select the Data tab and the select Filter -the funnel
in the middle (Figure 77).

e This will place boxed triangles to the right of the
column heading name.

s Data _' Review | View Bm‘uper e ﬂ

b i ey =y = %@ LAnE I I az
BE G & @Y% am t;::;p, = 51 = e =l
ilter

From From From From Other Existing Refresh L Sort Textto Remove Data Consolidate What-If Group Ungroup Subtotal B

Access Web  Text Sources~  Connections | Al =@ Edit Links 5 Advanced | Columns Duplicates Validation - Analysis = hd
Get External Data Connections Sort & Filter Data Tools Outline
At ~ @ fe| SSN
4 A | B [ ¢ ] D [ E T F T 6 [ H [ 1 [ o0 T K [ L [ ™
1 |SSN |~/ LAST_NAME ~ FIRST_|~|BIRTH_DT |~|GENDE| ~|CE_ID |~|SITE_IO »|MATCHI v |ELIGIBIL  |Haslnva ~ Data

FIGURE 75 FILTER

e Select the triangle in column J and click on the
checkmark beside (Blanks) to clear it. Select OK.
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loper Acrobat

& Clear
{s Reapply

o

Text to

BB = B

Remaove Data (ﬂniﬂllﬂﬂt! What-If

Columns

Analysis =
Data Tools

Group Un¢

F

9090
9090
9090
9090
9090
9090

1
9090
9090
9090

9090
9090
9090
9090
9090
9090
9090
9090

9090
anan

G

H [ 1 T 0 T K

| %

E ID_ - |SITE ID - [MATCHI - [ELIGIBIL - [Haslnval - Data
|2
|&

SortAtoZ
SortZto A
Sort by Color »

Text Fitters »
{Sealch Pl
:mﬂﬁhhnAn

¥ (Blanks)

o) (o)

FIGURE 76 CHOOSE FILTER PARAMETER

Just the records with errors remain. There is no
information about the type of error.

e Look at the first row with an error and locate the
row number on the left.

¢ In the file opened in Notepad, select Edit > Go to

(Figure 80).

0.1ar 1na, A Aldce, 1212088
0, I‘i?ﬂ. {21.-’2006
462880500, Chlll'!. 1, vicki
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e Enter the line number of the record that has invalid
data. For example, if the row number in the gray
box on the left side is 1256, enter1255 Subtract 1
from the row number because Note Pad does not
have a header row (Figure 81).

Go To Line @

Line number:
1256

GoTo || Cancsl

FIGURE 78 GO TO DIALOG Box

e The cursor will blink at the beginning of that row.
You can search to see if the issue was missing
leading zeroes in SSN, Birth Date, or CE ID. Correct
the error on the CSV (Invalid Data-Excel) file that
you are working on — not in Note Pad.

Common Errors include:

Too many or too few digits for SSN, DOB and/or
CE ID

Using the word NULL for SSN
Blank cells
Backslashes at the end of the DOB

Commas between double last names or double
first names. (Extra commas make additional
columns and then puts the wrong information in
the wrong column.)

Texas Department of Agriculture DCDV System User Manual
Correcting Invalid Data
Page 77



APPENDIX

16. List doesn’t look right; can’t print all the

pages

Does the Print/Download view look like this? (Figure
66)

Will it only print a few pages?

EIRTH DATE
SSN
LAST NAME EIRST NAME M SEX
lastname e
M 999999999 1003011900

KEYNON
lastname

A1 A1/04/1300

FIGURE 79 PRINT/VIEW ISSUES
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If you are using Internet Explorer, click on Tools in the
Menu bar at the top.

m'[.ﬂ' Wetps. e i bearagroulune e DC OV DOViewf eperaipa 1

Fle Edf  View Favorted Halp

i [l Chart Okpect Mermbers Dielete Browiang history... Carle Shift« Dl
| InPrecate Browding Ceile Shalt= P

Tracking I

i % Faberi

Dul]m;'.rcunnﬁlll;n prefiems.

Reaper lidt Estaming Lessin

| Add gte te Sae menu

o B

View dowmnioads Cire)
Pep:up Blecked "

it S e FOTer ¥
Lol il g, i

FIGURE 80 COMPATIBILITY VIEW SETTINGS

Add this website: should have texasagriculture.gov in

the box. If not, enter it and select Add and then select
Close.

Firefox has the same Print/Download issue, but
there is no fix for it. Use the Download option in
Firefox or use another browser for
Print/Download in Direct Certification.
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@ mmgmmmmhmh

[ Include updated website ksts from Microsaft
[¥] Display intranst sites in Compatibdity View
[ pisplay ol websites in Compatibiity View

[

FIGURE 81 COMPATIBILITY VIEW SETTINGS
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17. Redacting SSN
The Social Security Number (SSN) is one of the primary
fields used in the matching process. It is personal
identifiable information (PIl) and great care should be
used in securing documents and files that contain PII.

While the SSN is used in matching, it is not required for
records retention. This information can be removed or
redacted before printing or saving the file.

The easiest way to remove the SSN is to delete the
column.

e Select the column.
¢ Right-click and select Delete. (Figure 64)

e Or Clear Contents (This will leave an empty column)

i

n [ ~
1 [SSN ¥ o ’
2 |ssN Ea Copy
3 |ssN [, Paste Options:
4 |ssN
LSSN Paste Special...
B |SSN
7 ISSN Insert
ESSN Delete
9 [SSN Clear Contents
%g: #f Format Cells...
ESSN Column Width...
13 |SSN Hide
14 |sSN Unhide
15 |SSN
16 |SSN
17 |SSN

Figure 82 Delete Column
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If you need to retain the last 4 digits of the SSN for
identification purposes, you can use Text to Columns on
the Data tab.

e Select the column.
e Select the Data tab to open the ribbon.

e Select Text to Columns (Figure 65)

Wado-e _

Haome Insert Page Layout Farmulas Data Review View Developer Acrobat

2 |_—a |_—E| |_—le] |:LL‘_~[' | [E5] connections 4] K Clear *g

& Properties & Reapply
From From From From Other Existing Refresh o il Sort Filter T Textto  Remove
|| Access Web  Text Sources=  Connections A~ =2 Edit Links g Advanced | Columns Duplicates V
Get External Data | Connections | Sort & Filter |

FIGURE 83 TEXT TO COLUMNS

The Convert Text to Column Wizard will open.

e In Stepl, choose, Fixed width

-
Convert Text to Columns Wizard - Step 1 of 3 | ? 2 |
The Text Wizard has determined that your data is Delimited.
If this is correct, choose Next, or choose the data type that best describes your data.
Criginal data type
Choose the file type that best describes your data:
() Delimited - Characters such as commas or tabs separate each field.
Fixed width |- Fields are aligned in columns with spaces between each field.
Preview of selected data:
-
P
Cancel ]| < Back |[ Mext > ][ Finish
"
FIGURE 84 TeEXT TO COLUMN WI1ZARD STEP 1
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Didn’t get the
break line in the
right place?

Double click on
the break line to
remove it.

Click and drag on
the break line to
move it.

Step 2 — Click between the 4" and 5™ number from

the right to insert a break line. (Figure 67)

. [ |

Convert Text te Columns Wizard - Step 2 of 3

This screen lets you set field widths (column breaks).
Lines with arrows signify a column break.

To CREATE a break line, dick at the desired position.
To DELETE a break line, double dick on the line.
To MOVE a break line, dick and drag it.

Data preview

10

res
L
(=]
o]
n
=
v
=

*
SSSSSIEISSS -

333353
99999&
b33ssass

[F95958535 -
4 }

’ Cancel ]’ < Back

FiIGUrRE 85 TEXT TO COLUMN WIZARD STEP 2

Step 3 —A — Select Do not import column (skip) for
the first column — numbers before the break line.

(Figure 68) DO NOT SELECT FINISH YET!

Convert Text to Columns Wizard - Step 3 of 3 ? RS

This screen lets you select each column and set the Data Format.,
Column data format
() General

_ ‘General converts numeric values to numbers, date values to
() Text dates, and all remaining values to text.
o o ]
(@ Do notimport column (skip) I
Destination: | $As1 5

Data preview

3

[ Cancel ][ < Back ]

FIGURE 86 TEXT TO COLUMNS STEP 3-A
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e Step 3 — B Select the 2" column of numbers — the
four digits after the break line.

e Select Text. This will keep any leading zeroes.
(Figure 69)

Convert Text to Celumns Wizard - Step 3 of 3 |i|ﬂ—hj

This screen lets you select each column and set the Data Format.
Column data format

‘General converts numeric values to numbers, date values to
dates, and all remaining values to text.

Date: | MDY IZI Advanced...

Do nat import column (skip)

Destination: | $As1

Data greviﬂ

| Cancel || < Back |

FIGURE 87 TEXT TO CoLUMN WI1zARD STEP 3B

e Select Finish
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18. Password Protecting Files
Since these files have PIl (SSN, DOB), you need to
protect the files. One way is to set up a password
protection. You will need to enter the password to open
the file.

18.1 Identify Excel Version

The instructions for working with Excel differ based on
the version of Microsoft Office that you have. You may
be able to determine what version of Microsoft Office
you have by looking at the Start Menu. If not, the
following information may help you determine wich set
of instructions to use. Please note: The pictures are
from Word, but the same steps apply to Excel.

[ Ca
e Click on the Microsoft Gem Eor Start ¥ emblem
on the bottom left to open the Start Menu.

¢ Double click the Microsoft Office folder.

Maintenance

Mchfee

Microsoft Lync

Microsoft Mouse and Keyboard Center
Microsoft Office

Microsoft Office 2013

Microsoft Sitverlight

Mozilla Firefox

QuickTime -

FIGURE 88 START MENU

The programs listed inside of the folder will have the
year of release as part of the program name. Example:
Microsoft Excel 2010 is the 2010 edition (Figure 76).
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1 Microsoft Office
@I Microsoft Access 2010
Microsoft Excel 2010
@ Microzoft InfaPath Designer 2010
@ Microsoft InfoPath Filler 2010
@I Microsoft OneMote 2010
|0] Microsoft Outlook 2010
Microsoft PowerPoint 2010
@ Microzoft Froject 2010
[B] Microsoft Publisher 2010
@ Microsoft SharePoint Workspace 201
(W] Microsoft Word 2010
o Microsoft Office 2010 Tools

Fi1GURE 89 OFFICE MENU

18.2 Excel 2003
18.2.1 Identify Excel 2003

Office 2003 has text-based menus on the gray bar: File,
Edit, View, Insert, Format, Tools, Table, Window, and
Help. (The screen shots are based on Word, but it
works the same in Excel.)

o Click Help = About (Figure 77)

¢ In the About Dialog box, find the version on the top

line.
@ Document 1 - Microsoft Word HEE
© Flle Edit View Insert Format  Took  Table  Window W Type a question far help + X
i@ E ¢ Narmal ~ TimesMewRoman + 12 +| B J|@ Mirosoft Office WordHelp  FL ||

Microsoft Office Online

Contack Us

Custamer Feedback Options...

About Microsoft Office Word

¥

FIGURE 90 IDENTIFY EXCEL 2003
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About Microsoft Dffice Word

Micrasoft® Office Word 2003 (11,8313.8221) SP3 «
Part of Microsoft OFfice Professional Edition 2003

Copyright @ 1983-2003 Microsoft Corporation. All rights reserved.

Portions of Intemnational ComrectSpell™ spelling comrection system @ 1393 by Lemout 8 Hauspie Speech
Products M, All rights reserved, English thessurus content deweloped For Microsoft by Bloamsbury
Publishing Ple, French spelling checker, dictionaries, hyphenator tool, thesaunus and application @ 13942000
SYNAPSE Développernent, Toulouse (France). All rights reserved, Spanish Spelling Engine, Hyphenation
Engine, and Thesauns Engine @ 1398-2002 by STGNUM Gia. Ltda. Quita, Ecuador. All rights reserved.
French and Spanish bilingual dictionaties @ Langenscheidt K& Berlin and Munich 2000, Certain templates
developed For Microsoft Corparation by Irnpressa Systems, Santa Rosa, Califomia, Compare Wersions
©1993-2000 Advanced Seftwarz, Inc. &l rights reserved The American Heritage Dictionary of the English
Language, Third Edition Copytight © 1392 Houghton Miffin Sampany, Electranic version licensed From
Lermaut & Hauspis Speech Products MAY, &1l rights reserved,

This product is licensed to;

Wicrosoft Corporation
Product ID:

“iews the End-User License Agreement

‘\Warning: This computer pragram is protected by copyright law and international
treaties. Unauthorized reproduction or distribution of this program, or any portion of

it, may result in severe civil and criminal penalties, and will be prosecuted to the G

maximum extent possible under the lavw, EhE I ko |
Tech Support... |
Disabled Items... |

FIGURE 91 ABOUT DIALOG Box

18.2.2 Password Protect in Excel in 2003

e Go to the File menu and click Save As (Figure 79)

ﬂ Microsoft Excel -
Eﬂ Ei Format Tools

Data Window Hi

L

B

Save Workspace...

%3 File Search...

Permiszion 3

Web Page Preview

Page Setup...
FIGURE 92 EXCEL 2003 FILE > SAVE As

=y
=
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¢ Navigate to drive and/ or folder where you plan to
save the document in the Save in box at the top.

(Figure 80)

e Enter the document name and click OK.

Iy -Cuml.ur

b

Faces Save as type !Ml:rosnﬂ Office Excel Warkbook,

FIGURE 93 SAVE IN DIALOG Box

e From the Tools menu, click Options. (Figure 81)

Error Checking...

Shared Workspace...

Share Workbook...
Protection 3

Online Collaboration  » |

Formula Auditing ()

“opios. ]|

FIGURE 94 TooLs > OPTIONS

Texas Department of Agriculture DCDV System User Manual
Password Protecting Files

Page 88



APPENDIX

¢ On the Security tab, type a password in the field for
Password to Open (Figure 82).

¢ You do not have to add a password in the field for
Password to Modify.

View | Calcuation | Edt | General | Transition
Color | onal | Save | Error Chedking |
File encryption settings f,

Password to open:

File sharing settings for this
Password to modify: {
[ Read-only recommended [E

Privacy options

[7] Remove tion from file properties on save
Macro securi
Adjust the

FIGURE 95 SECURITY TAB PASSWORD FIELD

18.3 Excel 2007
18.3.1 Identify Office 2007

Office 2007 introduced tabs and the Microsoft Office
Button @ and a tab menu.
o Clic_:k the Microsoft Office Button

@ > Excel Options.

¢ In the Options dialog box, click Resources. Find the
version. (Figure 84)
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'(.1 zlli) ¥
'_Ij' 'N | Recent Documents
{4l
=
(7 Quen

@ Prepare  »

o end

L puslish >
T Clase 2
il :

lj Wiord c‘:)pqnns ] )_(mﬁgl"t_‘u';;a_]

FicurRF 96 OFFIcF 2007 GEM AND OPTIONS

Word Options
Popular GEI Contact Microsoft, find onling resources, and maintain health and reliability of your Mlcmwﬁ\ﬁm‘ 1
5 LY programs.
Display
Proofing get updates Chedk for Updates |
Save Get the latest updates available for Microsoft Office.
Tupograpty run Microsoft Office Diagnostics Disgriose
Advanced Diagnose and repair problems with your Microsoft Office programs,
Customize contact us Lantact Us |
Adaudns Let us know if you need help, or hows we can make Microsoft Office better,
Trust Center activate Microsoft Office . Acthvate |
= J cthiation Is required to continie Using all the features In tals product.
0 go te Microsoft Office Online Goonime |
{
= Getfree product updates, help, and online services at Migrosoft Office Gnline.
about Microsoft Office Word 2007 About
Microsoft® Office Word 2007 (12,0.6504.5000) 5P2 M5 OHE2.0.6529.5000)
|
]

FIGURE 97 OFFICE 2007 RESOURCES

18.3.2 Password Protect in Excel 2007

Ny
e Click the Microsoft Office Button @ > Save As. Use
the down arrow in the address box at the top to
navigate to where you plan to save the document.

e Enter the document name and click Save (Figure
85).
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[&] save As e
G@'“‘ » Libraries »|Documents |»] Bxcel [ 43 |[ Search Ercel )
Organize v New folder = @

3] Microsoft Excel Documents library P Fader =
Excel
f" Eavonisy Name ° Type Size
[ Libraries No items match your search.
@ Documents
&' Music
] Pictures
B® Videos
[ 5l n *
File name:  Numbers.xlsx v‘
Save as type! [El(cel ‘Workbook (".xlsx) V]
Authors: Owner Tags: Add atag
[F] Save Thumbnail
i
FIGURE 98 OFFICE 2007 SAVE As DIALOG Box

Click the Microsoft Office button, point to Prepare, and
then click Encrypt Document (Figure 86).

@ﬂﬂ-t‘- k

3 New Prepare the document for distribution

[ s Properties

s ] _gf‘ﬂ View and edit workbook properties, such

i 7 Qpen as Title, Author, and Keywords.

[ Inspect Document

| I Save Check the workbook for hidden metadata
of personal infarmation.

= ] Encrypt Document
hﬂ Saveds b | Increase the security of the workbook by
adding encryption.
@ Bt |l Restrict Permission
Grant people acoess while restricting their L4
ability to edit, copy, and print.

Prgpare k| | Add a Digital Signature
Ensure the integrity of the workbook by
R adding an invisible digital signatwre, |

FIGURE 99 OFFICE 2007 ENCRYPT DOCUMENT

In the Password box, type the password and select OK.
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18.4 Excel 2010
18.4.1 Identify Office 2010

Office 2010 introduces the File tab and the Microsoft
Office Backstage view.

Select File = Help

Under Product Activated, find the version (Figure 87).

L - o5 i= = @ =
(Dse st Pageloyout  References Malings  Review  View  Developer o @
| i save
Support | .
B swvess L0 Off Micsiohe
i @ Microsoft Office Help nn« Ice
o Close [® Getting Started
i 6 Contactls Product Activated
Microsoft Office Professional Plus 2010
Toels for Werking With Office This product contains Microsaft Access, Mic el Microsoft
Recent SharePoint Warkspace, Microsoft OneMote, Microsoft Outlook,
©  Options Microsoft PewerPaint, Microcoft Publisher, Microsoft Ward,
New Microsoft InfoPath,
8 Checkfor Updates Change Product Key
Print
About Microsoft Word
Save & Send Version: (32-bit)
Hel él Version and Copyright
e &/ Part of Microsoft Office Professional Plus 2010
1] Options 2 2010 Microsoft Corporation, All nghts reserved,
Migrosoft Customer Services and Support
Extt Product ID:
Mictosoft Seftware License Terms
FIGURE 100 IDENTIFY OFFICE 2010

18.4.2 Password Protect Excel 2010

See Password Protecting instructions for Office 2010,
Office 2013 and Office 365 (page 93)

18.5 Excel 2013 and Office 365
18.5.1 Identify Office 2013 and Office 365

Office 2013 and Office 365 still use the File tab and the
Microsoft Office Backstage view.

e Select File > Account
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¢ Under Product Information find the version. (Figure
88)

Deomrager], - Weed

Account
Liser Information Froguct Imformatesn
barar ks

ke 2

Sgoa Producl Adtaled

Sz A I'-ll proacit Offer Fiodedonal Pin,

Tha piadmi | i ialmr

Qfice: Background -

Ha Bz bgpom e = Crevegs Predar s

Office Themre: Aboar Word

haw - E loma ree shed o
Blnd LLE T l;nlrn-j

Cornecied Serdces: “dirart

FIGURE 101 ACCOUNT > PRODUCT INFORMATION

18.5.2 Password Protect in Excel 2010, 2013 and
Office 365

e Click File > Save as.

¢ Use the down arrow in the address box at the top to
navigate to where you plan to save the document.

e Enter the document name.

¢ Do not click Save yet. (Figure 89)
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@ Save As

®'|y » Libraries b‘Dacnments|b|Exca\

~ [ 44 || search Excet i

Organize Mew folder

=~ @

[#] Microsoft Excel
Excel

1’:{ Favorites

Name

4 Libraries
@ Documents

Jl Music

[E=] Pictures

¥ videos

Documenits library

Arrange by:  Folder =

-

Type Size

Mo items match your search.

ol ww -

1 | ’

File name:  Numbersxlsx

Save as type: IEKceI Workbook (*xlsx)

Authaors: Owner

Save Thumbnail

(+ Hide Folders

Tags: Addatag

Tools - [ Save Cancel

J |

FIGURE 102 EXCEL 2010+ SAVE As DIALOG

e Click on Tools (bottom right) > General Options
(Figure 90)
(Toos =) | save | | Cancel
Map Metwork Drive...
Web Opticns...
I General Options... [ I
Compress Pictures... =
FIGURE 103 TooLs > GENERAL OPTIONS
¢ In the Password to Open box, type a password and

select OK. Select Save( Figure 91).

File sharing
Password to open:

Password to modify:

Always create backup

Read-only recommended

ok | [ canca |

FIGURE 104 PASSWORD D1ALOG Box
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19. Adobe Acrobat Reader

You will need the Adobe Acrobat Reader to open the
Print/Download views of the DC and DV reports. The
reader is normally on every computer and by default is
set to update automatically.

Your district technology department may have the
automatic updates on a schedule. You may also have to
have administrator rights to update a district computer.

If the computer you are using requires an update to the
Adobe Acrobat Reader and doesn’t require
administrator rights, use the following instructions to
update the reader.

19.1 Download the Adobe Acrobat Reader

If you do not have Acrobat Reader, go to
get.adobe.com/reader to download it. There are three
steps to the process. Follow the instructions on the
screen.

There is an optional offer to install Google Chrome as
the default browser. Be sure to uncheck the box if you
do not want to do that.
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19.2 Check for Updates

e Open the Adobe Acrobat Reader. Open the Help
menu and select Check for Updates (Figure 92).

File Edit View Window I!!!

Home Tools ® Online Support

About Adobe Acrobat Pro DC...
FILE LISTS About Adobe Plug-Ins...
Sent
Generate System Report...

STORAGE
Repair Installation |

My Computer [ Check for Updates... )

Q Search

Document Cloud

Add Account

FIGURE 105 ACROBAT READER > CHECK FOR UPDATES

¢ If updates are detected, click Download to install the
updates. If no new updates are available, click
Close.

19.3 Enable Automatic Updates

Automatic updates are forced in Acrobat Reader DC,
with no option to turn them on or off. Earlier versions
such as Adobe Reader 11 feature an Updater option on
the Preferences window that lets you turn on automatic
updates.

e Open the Edit menu and select Preferences.

e Select Updater in the left pane. Check the box next
to Automatically Install Updates and then select OK.
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20. Excel Viewer

If you do not have Excel installed on your computer,
you will need an Excel Reader. Download it from
Microsoft Download Center.

Search for the Excel Viewer at www.microsoft.com.
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21. Enable Pop-Ups
Pop-ups are additional windows that open when you are
browsing the internet. Many times, they can be
annoying advertisements that appear automatically
without permission. To stop that, internet browsers
have added security features that disable pop-ups.

Pop-up are used by legitimate sites, such as banks and
TDA, to display individualized information. The DC and
DV sites use pop-ups to display content such as
response files. You can adjust your browser settings to
allow for pop-ups for only certain sites.

21.1 Enable Pop-Ups in Chrome

Touch the menu = on the right> Settings
e Select Show Advanced Settings at the bottom
e In the Privacy section, select Content Settings.

e Scroll down to find Pop-up. Select Manage
Exceptions.

e Enter texasagriculture.gov in the field box and select
Allow.

e Select Done.
e Select Done again.
e Close the browser tab.

Currently, there is no other way to manage the allowed
sites for Microsoft Edge.

21.2 Enable Pop-Ups in Firefox

e Select the menu button = on the right and choose
Options.
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¢ Select the Content panel.
e Select Exceptions in the Pop-ups section.

¢ Enter texasagriculture.gov in the Address of website
field at the top and then click Allow.

21.3 Enable Pop-ups in Internet Explorer

Click on the Gear button in the top right corner of the
screen.

Select Internet Options.
Click on the Privacy tab.
Select Settings in the Pop-up Blocker section.

Enter texasagriculture.gov in the field Address of the
website to allow. Select Add.

Select Close.
Select Apply on the Internet Options dialog box.

Select OK on the Internet Options dialog box.
21.4 Select Save Changes. Enable Pop-Ups in Microsoft Edge

Microsoft Edge will display a notice at the bottom of the
screen that a pop-up has been blocked with the option
to allow once or always allow.
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22. Tips for Completing the Verification Report

Verification Report (FNS-742)

« Required report for all SFAs and RCCIs operating the
Mational School Lunch F'I"DQI"EITI and/or the School
Breakfast Program

— SFAs that are Special Milk Only are exempt from filing
a verification report

- Verification process must be completed by November
15% on applications received by October 1%

« Based on student enroliment data of Oct 31%.
+ Report must be completed in TX-UNPS before Feb.1st

General Information

This will be auto-filled
General Information -

- with information. Please
ot / update with the contact
Verlication Contact Information information of the person
— Stien 5) f”"‘“ —— ! actually completing the
L tmalddress: | : report in case we need to
3. Phone: e e Fl::_— contact you .

4. Title:

Due Date: February 01,
Instructions

ANMUALLY, each SFA, including ALL RCCTs, with schocls aperating the Mational School Lunch Program (NSLP) andfar School
Breakfast Program (SBP) must report venification information. All SFAs, induding SFAs with all schools exempt from venfication
requirements, must complete applicable secbons.

NOTE: SFAs that are Special Milk Only are exempt from filing an SFA Venification Collection Report.

Texas Department of Agriculture DCDV System User Manual
Tips for Completing the Verification Report
Page 100



Section 2

Section 2 is for any SFA operating alternate provisions, such

as Provision 2 and CEP.
TX-UNPS Screen

Section 2 - SFAs with schools operating alternate provisions

APPENDIX

Onlly SFAs with altemative provisions must repor. Sections 2. Repor schools or inslilulions operating the NSLP andior SPB as of

the last eperating day in October

21 Operating Provision 2/3 in a BASE year for NSLP and SBP

22 Operating Provigion 2/3 in a NON BASE year for NSLP and SBP;

22a  Prowsion 2/3 students reported as FREE ina Non Base year,

226 Prowsion 2/3 students reported as REDUCED PRICED in a NON BASE year.
23 Operating the Community Eligibility Provision (CEP):

24 Operating other alternatives for NSLP and SBP:

25 Operating an altemative provision(s) for only SBP or enly NSLP:

Watch that you put the right
data in the right place.

MNumber of schools in Column A
MNumber of students in Column

B
A, Number of B. Number of Students
Schools AND
Institutions.
1A 2-1B
22A 228
2-2aB
2-2bB
2-3A 238
248 2B
2-5A 258

There are 3 parts to #2-2 (non-base year). Don’t skip if you answered

L=l

Section 3

Note - all SFAs must respond on Section 3

TXAUNPS Screen

—=  Section 3 — Students approved as FREE eligible NOT subject to verification

All sites must be either Provision 2 or CEP.
If RCCI, all students must be residential only.

Al SFAs must report Sechion 3 o check box 31, i apphcable. Repon shudents appeoved FREE elgible as of the last operating

day in October,

31 Check the box only if all schools andlor RCCls n the SFA wene not required 1o pedomm direct

ceification with SNAP (e NON BASE year Prowisson 273 for all schools)

32  Students directly certified through Nutriti

not include students ceriied with SNAP |I’|N)|gh the letter method.

33 Students directly certified through other programs: Include those directly cerlilied thiough
Temporary Assistance for Meedy Families (TANF), Food Distibution Program on Indian
Reservations (FOPIR), or Thise e s homeless, migrant,
munaway, foster, Head Stan, Pre-K, Even Start, ormn-q)ph:mt but approved by local oﬂumﬂs

DO NOT include SNAP students already reported In 3-2

34 Student certified categerically FREE eligible through SMAP letter method Include students
carified for frise maals through the Tamaly proveding a lether from the SNAP agency.

B.  HNumber of
Free Students.

Program (SMAP): Do

32

This is the number of students identified through Direct Certification.
Add the number of students certified on the State Match List and the
number of students matched and certified on the CEP Upload. This is
not an auto-fill from the Direct Certification in TX-UNPS.
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Most common mistake — switching number
of applications and students. The number in
A should be less than or equal the number in
. B, unless students that submitted
SeCt|0n 4 applications were directly certified in

October. Please keep documentation to

TRUNPS Sien support this if it happens.

Section 4 - Students approved as FREE or REDUCED PRICE eligible through a household applicatio

I SFA colletng ggcations s et Secion 4 Report number o appcations 4) pprned as o Oclober 12 Rt rmber of st B) s of el perting dayin O

A Number of B. Number of
Applications Students

1 Approved as categorcaly FREE Eligible. Based o hose pronding A e

documentafion (.. a case number for SNAP, TANF, FDPIR on applicafion)
41 Approved as FREE eligible. Based on househald size and mcome m B

information. These
&3 Approved as REOUCED PRICE eligible. Based on househald size and " e number'__-‘.are

inoome nformiation automatically

calculated
T4 Total FREE EligibleStudents Reported go(rsnas‘r;'zc;flons
T2 Total Reduced PRICE Eligible Students Reported ! i

Use your calculator to sum the

number of applications. You may
need that info in Section 5

Section 5

TA-UNPS Screen

Not sure if you should check
this? Call your ESC.

Section 5

All SFAs must report Section 5 or check box 5-1 if applicabile.

51 Check the box if ALL schools andior RCCIS are exempt from verification, or ALL schools are
Provision schools in a base year. 5
If 5-1 Is check, no further reporting in Section 5 is required.
32 Was verification performed and completed?
# Yes, completed by November 157
: Yes, completed after November 157
No, venfication was NOT or the was not com . . T .
53 Type of Verification m,w process pleted monthly imit of annual income within $1,200 of the annual mit
& Standard (Lesser of 3% or 3,000 emor-prone) of the applicable income eligiblity guidefines.
& AMiemate one (Lesser of 3% or 3,000 selected randomly)
& Allemate two (Lesser of 1% or 1,000 eror prone applications PLUS lesser of one-half of one
percent or 500 applications with SHAP/TNAF/FDPIR case numbers)
Total ERROR PRONE applications: Report all applications as of October 1% considered ermor prone.
Number of appli lected for verification sample:

Error-prone applcaions are household applicafions approved
as of Oclober 1= indicaing menthly income wihin $100 of the

b ¢

See next page for
instruclons on how fo
calculale sample size
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APPENDIX

Calculating 5-5

1. Add the number of applications from 4-1A, 4-2A, and 4-3A.

A. Number of
Applications

4-1 &9

4-2 175
4-3 71

=315
2. Multiply by the percentage in 5-3. (In this case = 3%)
315x.03=9.45
Round up to 10. (Always round up)

Any number besides 10 would be an error!
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APPENDIX

| |
S eCtI 0 n 5 » The number of applicaions are
reporied inthe fields ending in "3".
* The number of students are

5-6 Check the box if direct verification was not conducted in the SFA, [i.e. not ore of the scheools |
and/cr RCCIs in the SFA performed direct venfication). If 5-6 is checked, skip 5-7.
A. Number of B. Number of
Students

5-7 ﬂmd through d;m m*kﬂvq: Report ijFRsE:‘ :"ndi:l;?mucm Enunllccﬁn 5TA. 578 The number of appicalions in 57
- is confirmed througl rect verification with FOPIR/M
as of November 15th. and 58 should equal the number of

5.8 Results of Verification by Original Benefit Type applcaions in 5-5.
For each onginal benefit type (A, B, & C), report the number of apphcations and students as of
Howember 15th for each result category (1, 2, 3, & 4). Dc NOT indude students and apphcations
already reported in 5-74 or 5-73 (dwect verification applications and students).

A. FREE-Categorically B. FREE-Income C. REDUCED PRICE-Income
Eligible Certified as FREE based on | Certified as REDUCED PRICE
Certfied as FREE based ncome’household 5 based on income/household .
SNAP/TANF/FOPIR application e size spplicaticn IMPORTANT: If you
documentation (e.g. case verified applications
numiber) on application
a. b. - b - b. for cause, the results
Applications Students Applications. Students Applications. Students of that verification
1. ﬂﬂ-ll::ﬂdﬂ. NO 38A1a. 38A1b i 38B.1a 5-8B.1b. 3-8C-1a. 58C-1b must be reported in
3-8,
WME DUCED REDUCED PRICE REDUCED PRICE FREE
PRICE / FREE: 5-8A2a. 5.8A2b 5.8B 2a 58B.2b. 58C.2a. 58C.2b
:i,.,,h‘ to PAID: 58A.3a. 58A3b §iB.3a 58B.3b. 5-8C.3a. 58C-3b
P oniod 58AM  58AMb )|  58B4a  58B4b. | 58C4a  58C4b
VC-1 Total questionable applications verified for cause (Enter "N/A" if not applicable): Report the VC-1
num.barahpphmmnalﬂwmhr 15th venfied for cause in ddition to the venfication

reguirement.
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DECISION PATHS

23. Decision Paths
Decision paths are picture representations of the steps to take in determining eligibility.
The diamond shapes <>are questions or decision points. The rectangles |:| are action points,
There are 2 phrases that will help in making decisions

1. SNAP is always #1
2. The address is what matters.

23.1 SNAP is Always #1

More than 1 child in a household is on the direct certification list, but 1 is SNAP and the others
are TANF: All are DC SNAP because SNAP is ALWAYS #1

23.2 The Address is What Matters

In determining eligibility by association, the only question that needs to be asked and answered
is if the address is the address the same for all the children — are they living in the same
household?
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DECISION PATHS

FIGURE 106 STUDENT LISTED ON STATE MATCH LIST

Student is listed : :
Currently C Identify as SNAP in
on sta'lciitmatch enrolled? YES Eligibility =1 YES—p POS
No
( STOP ) No =0 or blank———» IdentlfyPagS'I'ANF n

FIGURE 107 SIBLINGS IN SNAP AND TANF

Siblings are on

match list. One

is SNAP. Oneis
TANF.

SNAP is always

Same
household?

Identify both as

Yes—» sNAPin POS #1

Identify in POS as
coded on match list
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DECISION PATHS

FIGURE 108 ELIGIBLE BY ASSOCIATION

SNAP eligible Just the
child residesin Identify all as SNAP | ° 00 address
household with Yes eligiblein the POS
children without system
SNAP eligibility

Identify only
children residingin
Doesn't matter No——— the same household
as SNAP eligiblein
the POS system
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Ficure 109 EDG NUMBER

Receive EDG# on
SNAP/TANF Letter
or application

Correctly
Formatted
Number?

DECISION PATHS

YES—>

Approve Eligibility

S ; Certify as DC
YE SNAP or TANF
MAY
A 4
Should request )
validation from HHSC validates? YES—p| Certify as DC
SNAP or TANF
HHSC
NO
N May contact
household
or
» May verify for cause
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24. Index
Acrobat Reader, 95
Active Session, 18
Address matters, 105
Browser Requirements, 13
CE Import Process, 28
CE Individual Search, 31
CE Upload
Correct Order of Columns, 58
Response File, 29
DC Data Process, 11
DC Email Address, 7
DC Policy, 10
DC Regulation, 9
DC report data, 24, 27
Direct Certification of Matches, 27
Direct Certification Reporting, 33
Download Certification List, 25
Equipment, 13
Excel Viewer, 97
Filter Data, 75
Find and Replace, 60
Folder Structure, 54
Format CE ID, 62
Format CSV Upload File, 58
Format DOB, 61
Format Excel
Header, 70
Margins, 69
Number of pages, 71
Print gridlines, 72
Repeat column headings on each
page, 72
Scale page, 68
Format Excel Spreadsheet, 66
Resize Columns, 66
Format SSN, 59
Invalid Data
How to correct, 74
LEA DC Process, 12
Logging-on to DCDV, 15

Matching Process, 12
Multiple CE IDs, 19
Naming Files, 58
Password change, 14
Pop-up Blocker, 18
Pop-ups

Enable in Chrome, 98
Enable in Firefox, 98
Enable in MS Edge, 99
How to enable, 98

Pop-Ups

Enable in Internet Explorer, 99

Print/Download Issues

Firefox, 79

Print/View lIssues

Firefox, 80
Internet Explorer, 78

Problem

Not all records on Excel
spreadsheet, 29

Printout doesn't look right, 22

Unauthorized User, 14

Records Retention, 10
Redact SSN, 81
Report Parameters, 21

Select Month, 21
Year-to-Date List, 21

Report Type, 20

CE Level Matches, 20
State Level Matches, 20

Save File Excel 97-2003, 56
Save File in Excel 2007, 56
Screen Resolution, 14
Security

Password Excel 2003, 87

Password Office 2007, 90

Password protect files, 85

Password Protect Office 2010, 2013
365, 93
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INDEX

Personal Indentifiable Information, Verification
9 Batch Upload of Records, 45
SNAP is #1, 105 Download matches, 50
SSN EDG number, 39
Remove dashes, 60 Manual Search, 39
State Match List, 19 Policy, 37
Tag DC in POS System, 27 Print matches, 49
Text file to Excel, 63 Time Period, 37
TX-UNPS User ID Verification Report, 100
Password, 14 View/Print Match List, 21

TX-UNPS website, 14
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